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[bookmark: _Toc510135604]Методические указания для обучающихся по освоению дисциплины 
Общие методические указания
Успешное усвоение курса предполагает активное, творческое участие студента на всех этапах ее освоения путем планомерной, повседневной работы. Студентам необходимо ознакомиться:
с содержанием рабочей программы дисциплины;
с целями и задачами дисциплины, ее связями с другими дисциплинами образовательной программы;
методическими разработками по данной дисциплине, имеющимися на сайтах библиотеки РГРТУ;
с графиком консультаций преподавателей кафедры.
К изучению дисциплины предъявляются следующие организационные требования:
обязательное посещение студентом всех видов контактных занятий;
качественная самостоятельная подготовка к практическим занятиям, активная работа на них;
активная, ритмичная самостоятельная аудиторная и внеаудиторная работа студента в соответствии с планом-графиком;
своевременная сдача преподавателю отчетных документов по контактным видам работ;
в случае наличия пропущенных студентом занятиям, необходимо получить консультацию по подготовке и оформлению отдельных видов заданий.
При подготовке к практическим занятиям студентам следует:
приносить с собой рекомендованную преподавателем материалы (конспекты лекций, литературу) к конкретному занятию;
до очередного практического занятия по конспектам лекций и рекомендованным литературным источникам проработать теоретический материал, соответствующей темы занятия;
задать преподавателю вопросы по материалу, вызвавшему затруднения в его понимании и освоении при решении задач, заданных для самостоятельного решения;
на занятии доводить каждую задачу до окончательного решения, демонстрировать понимание проведенных расчетов (анализов, ситуаций), в случае затруднений обращаться к преподавателю.
Студентам, пропустившим занятия (независимо от причин), рекомендуется обратиться к преподавателю в день консультаций и получить индивидуальное задание. 
Для выполнения практической работы обучающийся должен предварительно изучить необходимые темы теоретического курса и получить конкретные рекомендации от преподавателя о порядке и составе выполняемой работы.
По завершению изучения дисциплины сдается экзамен.
При подготовке к экзамену необходимо ориентироваться на конспекты лекций, рабочую программу дисциплины, учебную и рекомендуемую литературу. Основное в подготовке к сдаче экзамена – это проработка контрольных вопросов и систематизация теоретических знаний, подтверждение практическими примерами и выкладками.
Подготовка студента к промежуточной аттестации по дисциплине включает в себя три этапа: систематическая работа в течение семестра; непосредственная подготовка в дни, предшествующие экзамену по темам курса.
Возможные формы проведения экзамена: устный (в виде собеседования).
Экзамен проводится по вопросам, для успешной сдачи которого студенты должны понимать сущность вопроса, его смысл и уметь аргументировать структурные составляющие и подтверждать практическими примерами, что должно соответствовать компетенциям освоения дисциплины, указанным в рабочей программе.
Во время испытаний промежуточной аттестации студенты могут пользоваться рабочими программами учебных дисциплин, а также справочниками и прочими источниками информации, разрешенными преподавателем.
На экзамене нельзя пользоваться электронными средствами связи и материалами, неразрешенными преподавателем. Также не разрешается общение с другими студентами и несанкционированные перемещения по аудитории. Указанные нарушения являются основанием для удаления студента из аудитории с последующим проставлением в ведомости оценки «не удовлетворительно».
Методические указания к самостоятельной работе
Курс предусматривает аудиторную и внеаудиторную самостоятельную работу студентов, обозначенную рабочим планом дисциплины.
Для наиболее полного изучения дисциплины обеспечивается доступ каждого студента к библиотечным фондам и базам данных, по содержанию соответствующим полному перечню задач дисциплины, к методическим пособиям, фондам учебной литературы, а также наглядным пособиям.
Выполненные работы следует регулярно показывать педагогу. Качество работы проверяется преподавателем и должно учитываться при выставлении семестровой оценки по предмету.
Методические указания к выполнению практических и самостоятельных работ
[bookmark: _Toc345233621]1. основы работы в adobe audition
Цель работы: изучение основ работы с редактором Adobe Audition, основных элементов его интерфейса, операций работы с файлами и навигацией. 
В программе Adobe Audition CS6 предусмотрены три режима работы:
редактирование отдельных монофонических или стереофонических волновых форм (Waveform Editor); 
многодорожечное (мультитрековое) редактирование, при котором из отдельных волновых форм можно составить композицию (Multitrack Editor);
редактирование проекта для записи треков на аудио компакт-диск (CD Editor).
Технологию работы с Adobe Audition в режиме Waveform Editor можно сформулировать так: 
1) открыть файл или создать новый файл;
2) произвести редактирование; 
3) применить эффекты; 
4) сохранить результаты.
В режиме Waveform Editor имеется возможность редактировать, восстанавливать и улучшать звучание отдельных аудио файлов, таких, как записи голоса, оцифрованные старые виниловые записи и т.д.
1.1. Режим Waveform Editor
[image: ]Если после запуска программа находится в мультитрековом режиме, переключитесь в режим редактирования волновой формы, нажмите клавишу <9> или воспользуйтесь командой View > Waveform Editor главного меню, или воспользуйтесь кнопкой Waveform на панели инструментов. 
После переключения в режим Waveform Editor панель Editor переключается в режим редактирования волновых форм, а на панели инструментов станут доступны кнопки отображения мгновенного спектра [image: ] и тона [image: ].
Панель Editor занимает основную часть окна приложения. Если считать звуковой файл с диска или записать звук с любого из доступных входов звуковой карты, то в этом окне отобразится волновая форма – график зависимости значения громкости звукового сигнала от времени.
[image: ]
Возможный вид монофонической волновой формы показан на рисунке.
Горизонтальная ось —  это ось времени. Для выбора единиц измерения времени предназначено меню View > Time Display. Основные форматы представления времени:
Decimal (mm:ss:ddd) — в привычной форме (минуты : секунды : миллисекунды);
Compact Disc 75 fps — в стандарте CD Digital Audio с частотой 75 кадров в секунду;
SMPTE … fps — в стандарте SMPTE (часы : минуты : секунды : кадры) с частотами от 23.976 до 59.94 кадров в секунду;
Samples — при помощи номеров цифровых отсчетов звука (от начала волновой формы);
Bars and Beats — в музыкальных тактах и долях тактов.
При выборе в этом меню нового формата меняются: оцифровка горизонтальной оси панели Editor и формат отображения времени в полях ввода главного окна и диалоговых окон.
Вертикальная ось —  это ось громкости, для нее предусмотрены следующие варианты разметки:
в децибелах (относительно так называемой полной шкалы);
· максимальное значение громкости: 0 dB;
· абсолютная тишина: –∞ dB;
· усиление громкости в два раза: +6 dB;
· ослабление громкости в два раза –6 dB;
в процентах от максимального значения громкости сигнала, соответствующего 100%;
нормализованная разметка в виде десятичных дробей (единице соответствует максимальное значение громкости сигнала);
в виде цифровых отсчетов (sample values) —  значений, в которых хранятся цифровые данные звукового сигнала; в этом случае шкала зависит от разрядности сигнала.
Оцифровка вертикальной оси волновой формы переключаются командами контекстного меню.

Воспроизведение или запись начнется с того места на волновой форме, в котором располагается курсор (отображается как красная линия). Для установки курсора нужно щелкнуть на рабочем поле панели Editor один раз. Если же сделать двойной щелчок, то выделится тот фрагмент волновой формы, который отображается в панели Editor. Выделение произвольного фрагмента волновой формы происходит при перемещении указателя мыши с нажатой левой кнопкой.
[image: ]Иногда точность установки позиции курсора принципиально важна. В таких случаях следует воспользоваться одним из шести полей ввода панели Selection/View. 
В верхней строке (Selection) отображаются и могут быть отредактированы временные параметры выделенного фрагмента волновой формы, а в нижней (View) — временные параметры фрагмента волновой формы, отображаемого на экране.
Левый столбец (Begin) соответствует начальному моменту фрагмента волновой формы, средний (End) — конечному. В правом столбце (Length) содержится информация о длительности фрагмента.

[image: ]Масштабом отображения волновой формы по вертикали и горизонтали можно управлять либо с помощью инструментов панели Zoom, либо с помощью аналогичных инструментов, расположенных в правой нижней части панели Editor. 
Масштаб отображения волновой формы по горизонтали задается при помощи кнопок:
Zoom In (Time) — увеличить масштаб; 
Zoom Out (Time) — уменьшить масштаб;
Zoom Out (Full Both Axis) — отобразить всю волновую форму;
Zoom to Selection - увеличить масштаб так, чтобы на экране отображался весь выделенный фрагмент волновой формы;
Zoom In at In Point — увеличить масштаб и отобразить на экране левую границу выделенного фрагмента;
Zoom In at Out Point — увеличить масштаб и отобразить на экране правую границу выделенного фрагмента.
Для изменения масштаба отображения волновой формы по вертикали предназначены пункты Zoom In (Amplitude) и Zoom Out (Amplitude).
Чтобы помочь сориентироваться в том, какая именно часть волновой формы видна, над ее изображением расположена диаграмма, на которой отображается уменьшенная копия волновой формы, видимая область и выделенная область. 
[image: ]
Перемещая этот прямоугольник с помощью мыши можно "перематывать" волновую форму и изменять границы видимой области.

В режиме Waveform Editor можно редактировать аудиофайлы, имеющие один канал (моно), два канала (стерео 2.0) и шесть каналов (стерео 5.1). 
[bookmark: _GoBack]Для двухканального звука один из каналов представляет собой звук, воспроизводимый из левого динамика (L), а другой – из правого (R).  Для шестиканального звука добавляются дополнительно:
центральный канал (C);
канал низкочастотных эффектов (LFE);
левый и правый каналы окружения (Ls) и (Rs).
Adobe Audition позволяет работать отдельно с каждым из стереоканалов. Для выключения/выключения канала нужно щелкнуть на его обозначение на вертикальной оси. 

С помощью панели Transport (или аналогичных кнопок, расположенных в нижней части панели Editor) осуществляется управление записью и воспроизведением звука. Рассмотрим элементы управления на данной панели: 
[image: ]Stop  — кнопка остановки записи или воспроизведения. 
Play  — кнопка включения режима воспроизведения. 
Pause  — кнопка временной остановки записи или воспроизведения.
Move Playhead to Previous  — кнопка перемещения курсора к началу волновой формы или к предыдущему маркеру.
Rewind  — кнопка "обратной перемотки".
Fast Forward  — кнопка ускоренной перемотки вперед.
Move Playhead to Next  — кнопка перемещения курсора к концу волновой формы или к следующему маркеру.
Record  — кнопка включения режима записи.
Loope Playback  — кнопка включения режима циклического воспроизведения.
Skip Selection  — включение/выключения режима пропуска выделенного фрагмента при воспроизведения.
1.2. Команды работы с файлами
Команда Open позволяет открыть звуковой файл. Команда Save сохраняет редактируемый файл на диске с тем же именем, с которым он был загружен с диска. Команда Save Selection сохраняет в файле только выделенный фрагмент волновой формы. Команда Save All позволяет сохранить все волновые формы.
[image: ]Команда Close закрывает редактируемый файл. Команда Close All закрывает все файлы всех сессий. Команда Close Unused Media закрывает любые открытые аудио файлы, не используемые в мультитрековом режиме.
Команда Save As позволяет сохранить файл под новым именем и новыми параметрами. Наиболее часто в примерах будут использоваться следующие форматы:
AIFF (*.aif, *.aiff, *.aifc)
Windows PCM (*.wav);
MP3 Audio (*.mp3).
Формат Windows PCM сохраняет аудио данные без сжатия. Несмотря на то, что файл займет больше места на диске, именно в данном формате строго рекомендуется хранить все исходные и промежуточные результаты работы, так как:
аудио редактор работает именно с несжатым звуком;
не будет происходить потери качества при многократном открытии и сохранении данных.
Формат MP3 Audio (наиболее популярный формат хранения звуковых данных) использует алгоритм сжатия с потерями. То есть при сохранении в этом формате какая-то часть аудио информации будет удалена в процессе сжатия. В данном формате можно сохранять итоговый результат работы.
Параметр Sample Type содержит значение разрядности и частоты дискретизации. Настройки формата отображаются в поле Format Settings. 
1.3. Импорт аудио с Compact Disc Digital Audio
Команда File > Extract Audio from CD открывает диалоговое окно, предназначенное для извлечения аудиоданных с компакт-диска (CD Digital Audio) в программу Adobe Audition.
В раскрывающемся списке Device перечислены все имеющиеся в вашей системе устройства воспроизведения компакт-дисков. Нужно выбрать устройство, в котором установлен компакт-диск. В списке Track отображаются треки, их наименования и длительность. Треки, которые должны быть импортированы, необходимо отметить.
Для того, чтобы привести в действие процедуру извлечения аудиоданных с трека CD Digital Audio в Adobe Audition, нужно нажать кнопку ОК.
Контрольные вопросы
1. Режимы работы Adobe Audition.
2. Схема процесса работы в режиме Editor Waveform.
3. В чем назначение команды Save Selection?
4. Выбор формата файла для хранения промежуточных результатов.
5. Что появляется в главном экране программы после загрузки файла со звуковыми данными?
6. Что такое маркер?
7. Как можно точно установить маркер в конкретную позицию?
8. Управление масштабом отображения волновой формы.
9. Каким образом можно работать с отдельным каналом?
10. Какие возможны виды оцифровки вертикальных осей каждого трека?
11. Перечислите назначение элементов управления Transport?
12. Опишите импорт данных с CD-DA.
Задание
1. Изучить работу в режиме Edit Waveform.
2. Произвести импорт треков с заданного CD-DA.
3. Объединить все треки в единый аудио файл.
4. Сохранить полученный файл в формате Windows PCM.
5. Сохранить полученный файл в формате mp3. 
6. Сравнить размеры файлов, полученных в п.4 и п.5.
7. Преобразовать стерео файл, полученный в п.4 в моно. Сравнить размеры файлов.
8. Преобразовать файл, полученный в п.4, установив разрядность 8 бит. Сравнить размеры файлов и качество звука.
[bookmark: _Toc345233622]2. запись звука
2.1. Основные понятия. Этапы звукозаписи
Под процессом записи понимают преобразование сигналов в пространственное изменение состояния или формы некоторого физического тела (носителя записи) с целью сохранения в нем информации для последующего ее извлечения (получения). 
Информацию, сохраняемую в носителе записи, называют записью. Носитель записи, содержащий информацию, полученную в процессе записи, называют фонограммой.
Рассмотрим процесс записи звука в Adobe Audition при помощи портативного аудио интерфейса M-Audio Firewire Solo, микрофонов Shure P58, микрофон Invotone CM-610.
Для записи звука в Adobe Audition необходимо:
1) подключить аудио интерфейс к компьютеру;
2) подключить микрофон к аудио интерфейсу;
3) убедиться, что в настройках Adobe Audition выбрано нужное устройство звукозаписи и звуковоспроизведения;
4) выбрать параметры звукового файла (фонограммы);
5) установить такой уровень записываемого сигнала, чтобы искажения стали маловероятными.
2.2. Аудио интерфейс M-Audio FW Solo
2.2.1. Краткое описание
FireWire Solo – это профессиональный аудио интерфейс высокой разрядности со входами для микрофона, музыкального инструмента и линейными входами. 
На лицевой панели FireWire Solo расположены вход для микрофона (XLR) и вход для музыкального инструмента (¼-дюймовое гнездо), а на задней панели – два линейных входа и два линейных выхода. 
Входы для микрофона и инструмента имеют отдельные регуляторы уровня сигнала. Расположенный на лицевой панели переключатель позволяет выбирать входы лицевой панели (микрофон и инструмент) или задней панели (линейные входы). 
M-Audio FireWire Solo соединяется с портом FireWire компьютера при помощи кабеля IEEE 1394.
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Настоятельно рекомендуется не использовать "горячее подключение" устройств FireWire: подключать устройство следует только тогда, когда и компьютер, и устройство выключены.
2.2.2. Элементы управления лицевой панели
1. Вход для микрофона. Симметричный разъем XLR для подачи сигнала микрофонного уровня. Этот разъем подключен только в том случае, если переключатель входов Front/Rear (5) установлен в положение “Front” (выдвинут). Сигнал, поступающий на этот вход, отображается программным обеспечением Digital Audio Workstation (DAW) как левый моно сигнал входной стереопары.
2. Индикатор ограничения сигнала.
3. Индикатор фантомного питания. Этот индикатор светится, когда нажат выключатель фантомного питания (9), указывая на то, что на вход микрофона (1) подается питание постоянного тока напряжением 48 В.
4. Усиление микрофонного входа. Этот регулятор управляет коэффициентом усиления на микрофонном входе (1), изменяя его в диапазоне от 0 дБ дo +40 дБ или больше.
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5. Переключатель входов лицевой/задней панели.
6. Вход для гитары. Несимметричный ¼-дюймовый разъем для подачи сигнала инструментального уровня от электрогитары, бас-гитары или других инструментов. Этот разъем подключен только в том случае, если переключатель входов Front/Rear (5) установлен в положение “Front” (выдвинут). Сигнал, поступающий на этот вход, отображается программным обеспечением DAW как правый моно сигнал входной стереопары. 
7. Индикатор ограничения сигнала. Этот светодиод включен, когда уровень сигнала на входе для гитары (6) превышает –1 dBFS. Если индикатор ограничения сигнала постоянно горит, уменьшите коэффициент усиления входа для гитары (8).
8. Усиление входа для гитары. Этот регулятор управляет коэффициентом усиления на входе для гитары (6), изменяя его в диапазоне от 0 дБ дo +30 дБ или больше.
9. Выключатель фантомного питания. Этот выключатель подает фантомное питание постоянного тока напряжением +48 В для конденсаторных микрофонов, которым требуется внешнее питание. Когда фантомное питание включено, светится индикатор фантомного питания (3). Большинство современных динамических микрофонов или устройств линейного уровня можно безопасно подключать к канальным входам при включенном фантомном питании. Однако фантомное питание может вывести из строя некоторые старые ленточные микрофоны, а отдельные устройства с несимметричным выходом линейного уровня при включенном фантомном питании могут неправильно работать или выдавать прослушиваемый фон.
10. Регулятор выходного сигнала. Этот регулятор управляет уровнем выходного сигнала, подаваемого на линейный выход (18), расположенный на задней панели, и выход для наушников (11), расположенный на лицевой панели.
11. Выход для стереонаушников. Это ¼-дюймовое выходное стереогнездо TRS служит для подключения стереонаушников с целью мониторинга выходного сигнала. Уровень громкости регулируется регулятором выходного сигнала (10). 
12. Индикатор питания. Этот светодиод горит, когда устройство FireWire Solo подключено к источнику питания через сигнальный кабель или адаптер переменного тока.
2.2.3. Элементы управления задней панели
13. Вход адаптера переменного тока. Подключите к этому входу шнур прилагаемого адаптера переменного тока. Это нужно тогда, когда FireWire Solo работает с кабелем FireWire 6х4 контактов или при использовании FireWire Solo в качестве самостоятельного преобразователя аналоговых сигналов в цифровые. При работе FireWire Solo со стандартным кабелем FireWire 6х6 контактов адаптер переменного тока не требуется. 
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14. Петля для замка Кенсингтона. Эта петля предназначена для стандартного компьютерного устройства защиты от кражи. 
15. Порты FireWire. Два разъема FireWire (IEEE-1394). Один разъем применяется для подключения устройства к порту FireWire компьютера. Второй разъем можно использовать в качестве проходного для подключения других устройств к шине FireWire. 
16. Выход S/PDIF. Цифровой выход S/PDIF с коаксиальным разъемом RCA.
17. Вход S/PDIF. Цифровой вход S/PDIF с коаксиальным разъемом RCA.
18. Линейные выходы. Симметричные/несимметричные аналоговые линейные выходы с ¼-дюймовыми разъемами TRS. Уровнем сигналов на этих выходах управляет регулятор уровня выхода (10), расположенный на лицевой панели.
19. Линейные входы. Несимметричные аналоговые линейные входы с ¼-дюймовыми разъемами. Эти разъемы подключены только в том случае, если расположенный на лицевой панели переключатель входов Front/Rear (5) находится в положении “Rear” (утоплен). Входные сигналы, подаваемые на эти разъемы, отображаются программным обеспечением DAW как входная стереопара.
2.2.4. Установка драйверов
Не подключайте FireWire Solo к компьютеру, не выполнив программу установки. После завершения работы программы установки FireWire Solo можно подсоединить к порту FireWire компьютера при выключенном компьютере.
1. Вставьте в дисковод компьютера диск CD-ROM с драйверами FireWire Solo. Должно автоматически появиться диалоговое окно FW Audio Family Installation, позволяющее начать процесс установки. Нажмите кнопку Next, чтобы продолжить процесс. Если окно не появилось автоматически, выберите Run из меню Start и нажмите кнопку Browse. Найдите CD-дисковод и нажмите значок setup.exe, чтобы открыть диалоговое окно FW Audio Family Installation, затем нажмите кнопку Next, чтобы продолжить процесс.
2. Прочитав лицензионное соглашение, отметьте флажок "I accept", если вы согласны с его положениями. Затем нажмите кнопку Next, чтобы продолжить процесс. Программа установки скопирует необходимые файлы на жесткий диск компьютера.
3. В процессе установки вы увидите сообщение, предупреждающее о том, что ПО драйвера не прошло тестирование для получение логотипа Windows. Выберите пункт Continue Anyway и переходите к установке. Программа установки предложит включить параметры повышения быстродействия DVD/CD. В большинстве случаев нужно оставить значения этих параметров по умолчанию (выбрано). В случае сомнений обращайтесь к документации своего устройства DVD/CD. 
4. Когда программа установки завершит копирование файлов, появится экран Installation Complete (Установка завершена), после чего вам будет предложено выключить компьютер.
5. Выключив компьютер, подсоедините FireWire Solo к свободному порту FireWire компьютера и включите питание FireWire Solo. После этого включите компьютер. 
6. После полной загрузки Windows откроется Мастер установки нового оборудования. Выберите пункт по умолчанию “Install the software automatically”. Нажмите кнопку Next. Windows найдет и установит файлы FireWire SOLO Bootloader. Когда процесс установки Bootloader завершится, Windows найдет файлы драйвера FireWire Solo. Мастер установки нового оборудования запустится второй раз, чтобы установить программное обеспечение драйвера FireWire Solo.
7. Опять выберите Install the software automatically и нажмите кнопку Next. Windows установит файлы драйверов. Снова появится сообщение о тестировании на логотип Windows – нажмите Continue Anyway и дождитесь окончания процесса установки. 
8. Увидев экран Completing the New Hardware Wizard, нажмите кнопку Finish, чтобы завершить установку.
9. Теперь интерфейс M-Audio FireWire Solo установлен и готов к работе. 
2.2.5. Подключение микрофона и наушников
Подсоедините наушники к выходам FireWire Solo для наушников. Подсоедините микрофон к микрофонному входу на лицевой панели FireWire Solo.
2.2.6. Панель управления M-Audio Firewire Solo
Программное обеспечение драйвера FireWire Solo обеспечивает простой и в то же время мощный интерфейс с компьютером и программным обеспечением Digital Audio Workstation. Панель управления содержит четырехканальный программный микшер, который позволяет направлять сигнал с любого из четырех входов FireWire Solo (двух аналоговых и двух S/PDIF) на любой из четырех выходов (двух аналоговых и двух S/PDIF).

Страница микшера (Mixer)
Страница микшера коммутирует звуковой сигнал на выходы и обеспечивает управление аналоговыми и цифровыми выходами FireWire Solo, а также четырьмя виртуальными каналами, создаваемыми программным обеспечением DAW. Она содержит также индикаторы уровня входных и выходных сигналов, регуляторы уровня сигналов, кнопки стереосцепления и функции solo и mute: 
[image: ]Кнопки коммутации выходов. Каждую из четырех стереопар можно направить на любой из аналоговых или цифровых выходов FireWire Solo, нажав соответствующую кнопку выхода желаемой пары выходов. Они обозначены как 1/2 (аналоговые линейные выходы) и spdif (выходы S/PDIF). Можно выбрать любую пару выходов микшера или обе пары. Выходные сигналы этих каналов появляются на выбранных выходных шинах, показанных в рамке Output Bus в нижнем левом углу. Если для одной и той же пары выходов выбраны несколько каналов микшера, сигналы на выбранном выходе будут суммироваться. 
Кнопка стерео сцепления (Stereo Link). Уровнями входов каждой стереопары управляют программные регуляторы; пары можно сцепить для достижения стерео управления, нажав кнопку Link канала. Активная кнопка становится синей. Если канал сцеплен, то при захвате и перемещении движка регулятора оба движка будут перемещаться в унисон. 
Кнопка Mute. Выбор кнопки mute (она становится красной) приводит к прекращению подачи звука на выходы данной пары каналов. Если отменить выбор кнопки mute, подача звука на выходы этой пары каналов возобновится.
Кнопка Solo. Выбор кнопки solo (она становится желтой) приводит к прекращению подачи на аудио выход сигналов от всех других каналов; если отменить выбор кнопки solo, подача звука на все каналы возобновится. Можно выбрать несколько кнопок solo. 
Панорамные потенциометры. Пара каналов аппаратных входов снабжена также виртуальными панорамными потенциометрами (Pan). Как и в любом типичном микшере, они работают в сочетании с кнопками назначения выходов, позволяя направлять сигнал на нужный выход.
Страница оборудования
Страница оборудования (Hardware) предоставляет доступ к важным настройкам FireWire Solo. 
[image: ]Фактическая частота дискретизации (Sample Rate Detected). В этом поле отображается наблюдаемая в данный момент частота дискретизации сигнала из выбранного входного источника синхронизации. 
Размер буфера ASIO/WDM (ASIO/WDM Buffer Size). В этом поле можно выбрать размер буфера, с которым вы хотите работать. Чем меньше буфер, тем короче задержка (под «задержкой» понимается время, требуемое для прохождения выходного сигнала через звуковую программу и его появления на выходах), но при этом качество работы с медленными системами может ухудшиться. По умолчанию размер буфера устанавливается равным 256. 
Эта настройка позволяет адекватно решать обычные задачи, но при желании можно поэкспериментировать с меньшими значениями. Если при воспроизведении звука появляется заикание или потрескивание, попробуйте увеличить размер буфера. 
2.2.7. Работа с Firewire Solo
Установка уровней записи. Подключите микрофон ко входу Mic Input на лицевой панели устройства. Переключатель Front/Rear Input, расположенный на лицевой панели, должен находиться в положении “FRONT”. Установите правильное положение переключателя Phantom Power:
для микрофона Shure PG-58 переключатель должен быть в положении off;
для микрофона Invotone CM-610 переключатель должен быть в положении on.
Уровень сигналов, принимаемых с этого входа, будет отображаться на странице микшера как левый стерео вход индикаторов уровня Analog 1/2 In. 
Регуляторы каналов обеспечивают только ослабление – это означает, что входной сигнал можно уменьшить, но не увеличить. Если нужно усилить входной сигнал, делайте это при помощи регуляторов уровня сигнала на лицевой панели. Следите за тем, чтобы уровень записи не достигал цифрового ограничения (не заходил в красную зону). 
При помощи кнопок Output направьте выходной сигнал со входа Analog 1/2 на аналоговые линейные выходы FireWire Solo.
Запись звука. В Adobe Audition аналоговый микрофонный вход FireWire Solo будут отображаться как вход устройства M-Audio FW ASIO и обозначаться FW Solo Analog In 1. 
Установка частоты дискретизации.Если на странице Hardware панели управления FireWire Solo выбран внутренний (Internal) источник синхронизации (sync source), частота дискретизации сигнала будет определяться звуковой программой. 
2.3. Запись звука в Adobe Audition
[image: ]Убедитесь, что в диалоговом окне Edit > Preferences > Audio Hardware выбрано необходимое устройство ввода цифрового звука (M-Audio FW ASIO).
Для создания нового проекта, в который будет в дальнейшем записан звук, необходимо выполнить команду File > New > Audio File, которая откроет диалоговое окно New Audio File.
В списке Sample Rate выберите частоту дискретизации: 
44 100 Гц, если целью является создание музыкальной композиции;
48 000 Гц, если целью является запись звуковой дорожки для цифрового видео.
В группе Channels выберите режим: моно (Mono), так как запись будет производиться с использованием моно микрофонов Shure P58 и Invotone CM-610. 
[image: ][image: ]В группе Resolution выберите разрешение: 16-бит.
Adobe Audition предоставляет удобный инструмент для установки уровня записи. По умолчанию в нижней части окна расположены индикаторы уровня сигнала и шкала-линейка с отметками (панель Levels).
При двойном щелчке на шкале (командой контекстного меню Meter Input Signal) линейка начинает отображать текущий уровень сигнала. Одна из главных задач при записи состоит в том, чтобы уровень сигнала не доходил до 0 дБ, но в то же время не был малым (достигал -3 дБ..-6 дБ).
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Правее отметки 0 дБ друг над другом находятся индикаторы перегрузки каналов. Они загораются, если амплитуда сигнала достигает максимально допустимой величины. Если эта величина будет превышена сигналом, то произойдет переполнение разрядной сетки АЦП. На слух этот факт воспринимается как очень заметное искажение сигнала, особенно если переполнение разрядной сетки будет происходить часто или в течение большого интервала времени.
При записи с микрофона предугадать в точности закономерность изменения громкости записываемого звука невозможно. Но все же следует сделать пробу, отрепетировать то, что вам предстоит записывать (речь, вокал или игру на музыкальном инструменте). При этом можно в небольших пределах изменять расстояние от источника звука до микрофона и их взаимное расположение, а также громкость, с которой извлекается звук. 
Если индикаторы перегрузки часто срабатывают, следует выполнить следующие действия.
1) Остановить воспроизведение.
2) Регулировками на звуковой карты немного уменьшить уровень сигнала.
3) Сбросить индикатор перегрузки.
4) Вновь осуществить пробную запись.
Для выполнения записи звука достаточно нажать на кнопку Record. Для временной приостановки записи следует нажать кнопку Pause. Волновая форма сохраняется после нажатия кнопки Stop. 
Время записи можно контролировать, глядя на панель Time, по умолчанию расположенное в середине нижней части главного окна программы.
Контрольные вопросы
1. Понятие запись, фонограмма.
2. Основные этапы процесса звукозаписи.
3. M-Audio FW Solo. Элементы управления лицевой панели.
4. M-Audio FW Solo. Элементы управления задней панели.
5. Подключение микрофона и наушников.
6. Установка уровней записи звука.
7. Мониторинг входов при записи.
8. Настройки проекта при записи звука в Adobe Audition.
9. Контроль времени записи в Adobe Audition.
10. Контроль уровня громкости в Adobe Audition.
Задание
Целью дальнейших работ будет создание звуковой дорожки для анимационного фильма. Тема, длительность трека и содержание согласовываются с преподавателем. До начала процесса звукозаписи студент должен подготовить дикторский текст (иметь с собой до начала занятия распечатанный текст). 
1. Провести сеанс звукозаписи с использованием микрофонов (или видеокамеры), сделав не менее шести дублей. Три дубля сделать при помощи микрофона Shure P58, остальные – при помощи микрофона Invotone CM-610.
2. Перенести полученный материал на компьютер.
3. Все результаты (отснятое видео, записанный звук и т.д.) выполнения задания записать в архив с именем 
[bookmark: _Toc345233623]3. анализ звука
Цель анализа звуковой информации: оценить ее пригодность и наметить стратегию обработки, позволяющую устранить имеющиеся недостатки.
В нашем распоряжении имеются следующие средства анализа:
мониторинг (прослушивание) записи;
визуальный анализ волновой формы;
статистический амплитудный анализ;
визуальный анализ мгновенного спектра;
количественный анализ спектра;
фазовый анализ.
Для проведения анализа необходимо иметь представление о цифровой форме представления звука.
3.1. Цифровая форма представления звука
Звук в цифровой форме получается либо в процессе оцифровки звука в аналоговой форме, либо создается при помощи методов генерации звука. 
Преобразование аналогового звукового сигнала в цифровой называется аналогово-цифровым преобразованием (АЦП) или оцифровкой. Процесс АЦП заключается:
в осуществлении замеров величины амплитуды аналогового сигнала с некоторым временным шагом - дискретизация; 
последующей записи полученных значений амплитуды в численном виде – квантование.
[image: 70000000]Процесс дискретизации по времени – это процесс получения мгновенных значений преобразуемого аналогового сигнала с определенным временным шагом, называемым шагом дискретизации.
Количество осуществляемых в одну секунду замеров величины сигнала называют частотой дискретизации или частотой выборки.
Квантование (по амплитуде) – это процесс замены реальных (измеренных) значений амплитуды сигнала значениями, округленными до ближайшего уровня квантования. 
Пусть для записи одного значения амплитуды сигнала в памяти компьютера отводится N бит. С помощью одного N-битного слова можно описать 2∙N разных значений. Пусть амплитуда оцифровываемого сигнала колеблется в пределах от -1 до 1 условных единиц.
[image: ]
Каждый из 2∙N возможных уровней называется уровнем квантования, а расстояние между двумя ближайшими уровнями квантования – шагом квантования. Число N называют разрядностью квантования, а полученные в результате округления значений амплитуды числа – отсчетами или сэмплами (от англ. “sample” – “замер”).
Если используется беззнаковое представление значения отсчета, то значение младшего кванта равно 20, старшего – 2N-1, а для нулевого уровня (абсолютной тишины) – 2N/2–1.
Для того, чтобы сравнивать громкость отсчетов, используются логарифмические единицы измерения – децибелы. По следующей формуле рассчитывается, на сколько децибел один цифровой отсчет громче другого:
L = 20*lg(V1 / V2);
где V1 и V2 – значения сравниваемых отсчетов.
Данная формула позволяет сравнить, насколько один звук громче или тише другого. Разница в громкости между двумя отсчетами, значения которых отличаются в два раза, составляет 6 dB, в четыре раза – 12 dB и т.д. 
Для использования шкалы измерения громкости цифрового звука необходимо задание нулевого уровня, относительно которого будет рассчитываться уровень громкости всех остальных отсчетов. В качестве нулевого уровня для цифрового звука взято значение старшего кванта, при этом громкость рассчитывает по следующей формуле:
L = 20*lg(|V1-V0| / (VFS-V0)); 
где 
V1 – значение отсчета, для которого рассчитывается громкость;
V0 – значение отсчета нулевого уровня;
VFS – значение старшего кванта.

Полученная величина обозначатся dBFS - децибелы относительно полной шкалы (decibel ratio to full scale).
Согласно предыдущей формуле для старшего кванта и младшего кванта значение уровня громкости равно 0 dBFS. Для кванта абсолютной тишины значение уровня громкости равно -∞ dBFS.
Так как значение отсчета не может превысить значение старшего кванта (и стать меньше значения младшего кванта), то всегда выполняется соотношение: 
|V1-V0| < (VFS-V0)
значит, |V1-V0| / (VFS-V0) < 1.
Откуда следует, что:
-∞ dBFS ≤ L ≤ 0dBFS 
Описанный способ оцифровки сигнала - дискретизация сигнала во времени в совокупности с методом однородного квантования - называется импульсно-кодовой модуляцией (ИКМ, англ. Pulse Code Modulation – PCM). Стандартный аудио компакт-диск (CDDA) хранит информацию в формате PCM, с частотой дискретизации 44.1 кГц и разрядностью квантования 16 бит.
3.2. Мониторинг
Прежде всего, записанный звук следует внимательно и многократно прослушать. Цель такого прослушивания состоит в том, чтобы оценить пригодность записи для дальнейшей обработки, а также отбраковать фрагменты, содержащие грубые ошибки.
Если делалась многократная запись одного и того же материала, то на этом этапе следует выбрать дубли с самым высоким качеством записи. Если нет ни одного дубля, полностью от начала до конца пригодного для дальнейшей обработки, то можно выбрать несколько дублей, и в дальнейшем следует смонтировать необходимую запись из лучших фрагментов разных дублей. 
При мониторинге следует обращать внимание на следующие моменты:
наличие постоянных фоновых шумов;
наличие щелчков;
наличие искажений тембра.
3.3. Визуальный анализ волновой формы
При визуальном анализе волновой формы следует обратить на следующее:
максимальный уровень громкости сигнала;
как часто достигается ли уровень громкости 0 дБ;
присутствуют ли в записи постоянные фоновые шумы;
присутствуют ли в записи щелчки;
динамика звука (переходы от тихих звуков к громким).
3.4. Статистический амплитудный анализ
Результат амплитудного анализа будет использоваться при решении вопроса о целесообразности борьбы с некоторыми искажениями, и при выборе параметров динамической обработки записанного сигнала.
Сбор статистической информации о волновой форме осуществляется с помощью окна Amplitude Statistics, открываемого командой Window > Amplitude Statistics.
Окно содержит три вкладки: General — статистическая информация о параметрах волновой формы, RMS Histogram — гистограмма (распределение значений) отсчетов волновой формы и RMS Settings – настройки для расчета гистограммы.
Вкладка General содержит статистическую информацию или о выделенном звуковом фрагменте, или обо всей волновой форме. 
[image: ]В столбцах для стереоканалов (или в единственном столбце в случае монофонического сигнала) представлена статистическая информация, наиболее важными из которых являются следующие: 
Peak Amplitude – пиковая амплитуда сигнала;
Possibly Clipped Samples – количество отсчетов, имеющих уровень 0 дБ (клипированных отсчетов);
DC Offset – уровень постоянной составляющей в выделенном фрагменте волновой формы;
Minimum RMS Power – минимальное значение среднеквадратичной мощности;
Average RMS Power – среднее значение среднеквадратичной мощности;
Dynamic Range – динамический диапазон сигнала;
Dynamic Range Uses – использованный динамический диапазон;
Loudness – громкость;
Perceived Loudness – воспринимаемая громкость (с учетом чувствительности слуха человека);
При расчете среднеквадратичной мощности используется следующий метод:
вся временная ось разбивается на небольшие интервалы постоянной длины, которое задается в поле Window Width на закладке RMS Settings;
в каждом интервале сигнал сравнивается с эталонной волной (либо синусоидальной, либо состоящей из прямоугольных импульсов, громкость которой считается равной 0 дБ);
осуществляется расчет минимальной, максимальной (Minimum/Maximum RMS Power), средней и суммарной громкости (Average RMS Power, Total RMS Power) на основе значений, рассчитанных для всех интервалов.
3.4.1. Пиковая амплитуда
Параметр Peak Amplitude – это максимальный уровень громкости звукового отсчета в выделенном фрагменте. Значение пиковой амплитуды определяет, на какую величину можно произвести усиление амплитуды без искажений. Например, если пиковая амплитуда равна -3.1 дБ, то можно увеличить амплитуду сигнала на +3.1 дБ.
По значению пиковой амплитуды нельзя сравнивать громкость двух аудио фрагментов, так как этот параметр не дает информации о средней громкости на протяжении всего отрезка времени. 
3.4.2. Клипированные отсчеты
Клипирование - это искажение, возникающее из-за неправильной регулировки уровня записываемого сигнала или из-за его случайного увеличения во время записи, приведшее к переполнению разрядной сетки аналого-цифрового преобразователя. 
Клипирование проявляется как искажение, крайне неприятное для слуха. 
Значение Possibly Clipped Samples – это количество клипированных отсчетов, то есть отсчетов, имеющих уровень 0 дБ. 
[image: ]Примечание: при редактировании Adobe Audition допускает превышение уровня громкости в 0 дБ. При сохранении эти отчеты станут клипированными.
Если количество клипированных отсчетов невелико (не превышает несколько десятков), то от клипирования можно будет в дальнейшем избавиться при помощи соответствующей обработки, иначе материал следует переписать его заново.

3.4.3. Смещение постоянного тока
Параметр DC Offset – уровень постоянной составляющей в выделенном фрагменте волновой формы. Если уровень постоянной составляющей равен 0%, то колебания волновой формы происходят относительно линии нулевой громкости (рисунок слева). Это нормальное значение параметра DC Offset.
[image: ][image: ]Если уровень постоянной составляющей отличен он нуля, то колебания происходят относительно линии. отличной от линии нулевой громкости (рисунок справа). 
Значение данного параметра не влияет на восприятие записи, однако, при обработке необходимо будет избавиться от постоянной составляющей, так как наличие постоянной составляющей уменьшает динамический диапазон звука. 
Например, если DC Offset = 20%, то на соответствующую величину будет меньше максимально возможная громкость. Кроме того, при монтаже звуков с разными значениями данного параметра будут слышны щелчки в местах склейки.
3.4.4. Громкость звука
Параметр Minimum RMS Power – это минимальное значение среднеквадратичной мощности. 
Если величина данного параметра ниже -85 дБ, то это говорит о наличии в записи фрагментов абсолютной тишины. Чем больше величина данного параметра, тем громче фоновый шум в записи.
Громкость следует оценивать по параметрам Loudness и Perceived Loudness. Именно по данным параметрам, а не по пиковой амплитуде, нужно сравнивать громкость различных записей.


3.4.5. Гистограмма
[image: ]Гистограмма — широко распространенная (особенно в вероятностном анализе) форма представления информации о каком-либо случайном процессе. 
В данном случае гистограмма представляет собой график зависимости количества отсчетов, мощность которых попадает в заданный интервал, от величины отсчета, выраженной в децибелах. 
На основе анализа формы гистограммы можно полчить следующую информацию:
уровень фоновых шумов;
уровень ограничения для динамической обработки.
Если гистограмма ведет себя монотонно (верхний рисунок), то либо в записи не присутствуют фоновые шумы, либо по громкости они неотличимы от полезного сигнала. Если гистограмма ведет себя немонотонно (рисунок справа), то левая часть – это шумы, правая - полезный сигнал. Для дальнейшей обработке необходимо запомнить грани[image: ]цу шума, в данном случае это 
-45 дБ. 
Правая часть гистограммы содержит информацию о самых громких отчетах. Как правило, число таких отчетов невелико, и при динамической обработке они ограничиваются лимитером. По гистограмме следует определить примерную границу для лимитера, в данном случае это 
-10 дБ.
3.5. Визуальный анализ мгновенного спектра
Команда View > Show Spectral Display включает режим отображения мгновенного спектра сигнала в виде градаций яркости и цвета. По горизонтальной оси отложено время, по вертикальной – частота. 
Цвет и яркость отображения зависят от уровня спектральной составляющей в анализируемой волновой форме на той или иной частоте (чем ярче — тем выше уровень). По умолчанию нулевой уровень соответствует черному цвету, по мере увеличения уровня появляется красный цвет, а максимальный уровень отображается белым цветом.
[image: ]
На рисунке представлен мгновенный спектр сигнала дикторского текста. Области с относительно широким спектром соответствуют словам, с узким — паузам между ними.
Просмотр волновой формы в режиме Spectral Display позволяет визуально определить и выделить диапазон, содержащий шумы или отдельные искажения. 
[image: ]
Затем можно применять инструменты шумоподавления для решения таких проблем как: 
А – высокочастотное шипение;
B – щелчок;
С – низкочастотный гул.
[image: ]При просмотре мгновенного спектра можно обнаружить наличие тональных шумов (шумов на постоянной дискретной частоте). В окне мгновенного спектра тональные шумы отображаются в виде отдельных горизонтальных линий на протяжении всего времени.
Тональные шумы могут возникать по разным причинам:
собственный шум оборудования (обычно высокие частоты, выше 10 кГц);
внешний фоновый шум - свист;
наводки от сети переменного тока (частоты близки к 50 Гц, 150 Гц, 250 Гц и т.д.).
3.6. Классический спектр
Командой Window > Frequency Analysis открывается окно спектрального анализатора. 
При открытии окна происходит предварительный расчет спектра короткого фрагмента волновой формы, начало которого совпадает с позицией курсора. Если же выделен фрагмент волновой формы (или даже вся волновая форма), то рассчитывается средний спектр сигнала.
Если анализировать спектр в процессе воспроизведения волновой формы, то в окне Frequency Analysis будет отображаться изменение значений мгновенного спектра.
[image: ]Расчет спектра производится раздельно для правого и левого каналов. 
Если в списке Scale выбран элемент Linear, то горизонтальная ось размечается в линейном масштабе. В линейном масштабе удобнее рассматривать весь спектр в целом, включая его высокочастотную область. Если выбран элемент Logarithmic, то по горизонтали устанавливается логарифмический масштаб. Логарифмический масштаб позволяет наблюдать низкочастотную часть спектра в деталях. 
Для настройки детализации отображения мгновенного спектра следует включить отображение дополнительных опций (кнопка Advanced) и в списке FTT Size выбрать размер выборки для расчета спектра. Чем больше значение, тем больше точность расчета спектра, но тем дольше расчет будет происходить.
При анализе классического спектра следует обращать внимание на следующее:
[image: ]верхняя частота ограничения спектра (на рисунке – около 13 кГц);
наличие наводок от сети переменного тока (частота 50Гц и ее нечетные гармоники);
наличие низкочастотного гула (область спектра ниже 100Гц).
3.7. Фазовый анализ
Моносовместимость – это свойство звукового файла, которое позволяет его прослушивать на монофоническом оборудовании. 
Несовместимость музыкальной композиции с монофоническим оборудованием появляется тогда, когда компоненты звукового сигнала левого и правого каналов оказываются в противофазе. Так как при преобразовании стерео сигнала в монофонический сигналы левого и правого каналов суммируются, то звуковые компоненты, находящиеся в противофазе, "гасят" друг друга, в результате чего возникают неприятные на слух искажения. Партии некоторых инструментов могут вообще "исчезнуть" из композиции. В первую очередь это утверждение относится к партиям, панорамированным в центр.
В компьютерной музыке такая ситуация является следствием применения специальных эффектов, изменяющих фазу звукового сигнала. Моносовместимость важна при передаче музыкальных композиций по радио и при сведении мультитрековой композиции. 
Определить на слух моносовместимость фонограммы без переключения в режим моно невозможно. 
[image: ]В Adobe Audition есть возможность контроля моносовместимости сигнала с помощью окна Phase Meter, открываемого командой Window > Phase Meter. 
Фонограмма является моносовместимой, если при проигрывании индикатор текущей фазы находится в зеленой зоне. Фонограмма мононесовместима, когда индикатор текущей фазы лежит в отрицательной области (от -1.0 до 0.0).
Контрольные вопросы
1. Основные средства анализа.
2. Дискретизация. Квантование.
3. Уровень громкости цифрового звука.
4. Мониторинг.
5. Визуальный анализ волновой формы.
6. Статистический амплитудный анализ. Пиковая амплитуда. Клипирование. Смещение постоянного тока. Громкость звука. Гистограмма.
7. Визуальный анализ мгновенного спектра.
8. Классический спектр.
9. Фазовый анализ.
Задание
Провести анализ каждого дубля по следующим пунктам.
Мониторинг – прослушать каждый дубль, определить качество записи каждого дубля, оценить качество записанного материала (как диктор читает текст, есть ли погрешности записи и т.д.). 
Визуальный анализ волновой формы – определить динамику записи, наличие участков абсолютной тишины, наличие клипирования, наличие щелчков, наличие шоновых шумов и т.д.
Статистический амплитудный анализ – сравнить все дубли по следующим параметрам: пиковая амплитуда, смещение постоянного тока, количество клипированных отсчетов, громкость и воспринимаемая громкость, минимальная среднеквадратичная мощность. Проанализировать гистограмму каждого дубля, определив наличие и границу фоновых шумов, а также уровень для ограничения громкости.
Визуальный анализ мгновенного спектра – определить наличие и количество фоновых шумов, шумов оборудования, наличие низкочастотного гула, наличие щелчков. 
Анализ классического спектра – определить наличие низкочастотного гула, наличие наводок от сети переменного тока, определить верхнюю границу ограничения спектра. 
Анализ фонограммоы на моносовместимость. 

Результаты анализа оформить в виде отчета. Все этапы анализа сопровождать описанием и экранными копиями диалоговых окон, волновых форм, экрана мгновенного спектра, подтверждающих сделанные в результате анализа выводы. 

Выбрать по результатам анализа лучший дубль из всех записанных.
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4.1. Основные понятия
Шум – это любой посторонний нежелательный звук, присутствующий в аудио материале. Примеры шумов:
шипение усилителя;
шум уличного движения;
наводки от сети переменного тока;
периодические щелчки на оцифрованной записи виниловой пластинки.
Искажение – это нежелательное изменение формы звуковой волны. Примеры искажений:
клипирование;
джиттер-эффект;
нелинейные искажения звукового сигнала, полученные при прохождении через усилитель c нелинейным коэффициентом передачи.
С точки зрения частотного анализа все виды шума можно разделить на две группы:
тональные шумы (неслучайные). У тонального шума в спектре присутствует одна или несколько дискретных частот.
случайные шумы. Спектр случайного шума является непрерывным в широкой полосе частот.

Особенности шумоподавления:
случайный шум во время речи не может быть полностью устранен, если он возникает одновременно с речью и в том же частотном диапазоне;
нельзя избавиться от случайных шумов, не ухудшая речи, но можно снизить их надоедливость;
можно понизить уровень тональных шумов, а в некоторых случаях полностью их устранить.
4.2. Редактирование мгновенного спектра 
В режиме отображения мгновенного спектра вы можете использовать следующие инструменты для того, чтобы выделить звук в определенном частотном диапазоне:
Marquee Selection – выделение прямоугольной области, 
Lasso Selection – выделение при помощи лассо, 
Paintbrush – эффект кисти. 
Применение этих инструментов позволяет осуществить детализированную и гибкую обработку звука, в том числе и для процесса шумоподавления. 
Эффект Paintbrush позволяет создавать уникальные выделенные области, которые задают мощность применения эффектов (задаются параметром Size (размер кисти) и Opacity (непрозрачность) на панели инструментов). Чем ближе цвет выделенной области к белому цвету, тем сильнее будет применен эффект.
Для быстрого исправления небольших дискретных искажений, таких как отдельные хлопки и щелчки, следует использовать инструмент Spot Healing Brush. 
[image: ]Для использования данного средства следует выполнить следующие действия: 
в режиме Spectral Frequency Display выберите инструмент Spot Healing Brush; 
на панели инструментов установите размер кисти (Brush Size). 
в главном окне щелкните или проведите мышью по области искажения.
В режиме отображения мгновенного спектра категорически не рекомендуется корректировать низкочастотные составляющие сигнала, так как исправление может затронуть основные гармоники речи.
4.3. Удаление нетональных шумов
Для удаления нетональных шумов необходимо иметь информацию о шуме: чем больше статистических свойств шума известно, тем эффективнее процесс шумоподавления. 
[image: ]Информацию о шуме Adobe Audition может получить, анализируя спектр фрагмента волновой формы, содержащий только шумы (шипение микрофона, фоновые звуки и т. п.). При выполнении процесса шумоподавления будет считаться, что выбранный фрагмент содержит только шум.
Шумоподавление в Adobe Audition выполняется с помощью диалогового окна Noise Reduction, открываемого командой Effects > Restoration > Noise Reduction.
Рассмотрим алгоритм работы с данным инструментом. 
1. Прежде чем вызывать окно шумоподавления, необходимо в главном окне программы выделить фрагмент волновой формы без полезной информации, но содержащий характерный для этой волновой формы шум. Желательно, чтобы этот фрагмент был как можно длиннее. 
2. Выполнить команду Effects > Restoration > Noise Reduction. В открывшемся окне нажать кнопку "Capture Noise Print". Запустится процесс анализа спектра выделенного фрагмента, который отобразится в верхнем координатном поле. 
3. На координатном поле отображаются три графика: 
a.  красный: минимально возможный уровень шумоподавления;
b.  желтый: минимально возможный уровень шумоподавления;
c.  зеленый: текущий уровень шумоподавления.
Величина последнего параметра регулируется параметром Noise Reduction.
4. Характеристики шума можно сохранить в файле, воспользовавшись кнопкой Save the current noise print. Теперь, если в будущем вы захотите очистить от шума аудио файл, записанный в той же шумовой обстановке, нужно будет нажать кнопку Load a noise print from disk и загрузить соответствующий файл с характеристиками шума (и не выполнять расчет профиля шума повторно). 
5. Снять флаг Output Noise Only (выводить только шум), если он был установлен. Нажать на кнопку "Preview Play/Stop". Прослушивая фрагмент с шумом, установить значение параметра Noise Reduction, при котором шум становится практически не слышен (абсолютной тишины добиваться не следует). Если выбрать порог подавления слишком высоким, то улучшения субъективного ощущения тишины в паузах не будет, зато в сигнале появятся искажения в виде металлического призвука.
6. Установить флаг Output Noise Only. Прослушивая звук и уменьшая значение Noise Reduction, добиться, чтобы не удалялись полезные составляющие звука (то есть при прослушивании не были бы слышны отдельные гласные, согласные звуки и т.п.).
7. Попеременно выполняя п.5 и п.6 установить компромиссное значение параметра Noise Reduction, чтобы, с одной стороны, обеспечивать достаточный уровень шумоподавления, а с другой – не удалять полезный сигнал.
4.4. Устранение клипирование
[image: ]Клипирование - это искажение, возникающее из-за неправильной регулировки уровня записываемого сигнала или из-за его случайного увеличения во время записи, приведшее к переполнению разрядной сетки аналого-цифрового преобразователя. 
Клипирование проявляется как искажение, крайне неприятное для слуха. 
Лучше не использовать материал, содержащий клипированые фрагменты, а переписать его заново. Однако, если такой возможности нет, то необходимо использовать эффект DeClipper, открываемый командой Effects > Diagnistics > DeClipper. 
Нельзя избавиться от клипирования, просто уменьшив громкость: формально клипированных отсчетов не будет, но само искажение останется.
Параметр Gain — усиление (фактически – ослабление, так как значения только отрицательные) сигнала перед обработкой. От этого параметра будет зависеть общая громкость звучания аудио файла после обработки. 
Алгоритм избавления от клипирования следующий:
установить значение параметра Gain вручную или установить флаг Auto;
нажать кнопку Scan;
нажать кнопку Repair All.
4.4. Устранение щелчков
[image: ]Средства Diagnistics > DeClicker и Noise Reduction & Restoration > Automatic Click Remover позволяют определить и удалить такие искажения, как щелчки и хлопки. 
Данные инструменты следует применять: 
для удаления щелчков из оцифрованной записи виниловой пластинки;
для исправления звучания взрывных согласных в записи вокала;
для удаления щелчков, вызванных записью на радио-микрофон.
Для того, чтобы найти щелчки на волновой форме, следует переключиться в режим отображения Spectral Frequency Display. Большинство щелчков будут видны как вертикальные линии, яркие на всей полосе частот. 
Параметр Threshold (порог) определяет чувствительность к шуму. Уменьшение параметра позволяет обнаружить больше хлопков и щелчков, но может захватить звук, который вы желали бы сохранить. 
[image: ]Параметр Complexity (Сложность) позволяет задать сложность обработки. 
Увеличение параметра увеличивает обработку звука, но может ухудшить качество звука.
Контрольные вопросы
1. Шум. 
2. Искажение. 
3. Виды шумов.
4. Шумоподавление редактированием мгновенного спектра.
5. Удаление нетональных шумов.
6. Устранение клипирования.
7. Удаление щелчков.
Задание
Проанализировать собственную запись на наличие шумов и искажений (использовать результаты выполнения предыдущей работы). 
В качестве фонограммы использовать лучший по результатам анализа дубль.
Определить алгоритм шумоподавления:
нужны ли исправления в окне редактирования мгновенного спектра (шипение, отдельные искажения, тональные шумы);
нужно ли проводить шумоподавление с использованием инструмента Noise Reduction;
нужно ли избаляться от клипирования;
нужно ли избавляться от щелчков и хлопков. 
Обоснованно применить инструменты шумоподавления. 
Внести в отчет описание и результаты работы по каждому применяемому инструменту шумоподавления.
Предоставить фонограмму до и после шумоподавления.
[bookmark: _Toc345233625]5. редактирование звука
После проведения анализа записи и шумоподавления необходимо:
удалить наименее удачные дубли;
вырезать посторонние звуки и паузы;
провести редактирование амплитуды (нормализация, fade in/out).
5.1. Монтаж
Для удаления фрагмента волновой формы необходимо:
1) выделить требуемый фрагмент;
2) передвинуть начало и конец выделенного фрагмента в те позиции, где звуковая волна пересекает нулевой уровень;
3) выполнить удаление.
Если не выполнить п.2, то после удаления на границах фрагмента могут появиться щелчки. Чтобы этого избежать, следует применить команды из меню Edit > Zero Crossings, которое содержит команды, которыми можно передвинуть начало и конец выделенного звукового блока в те позиции, где звуковая волна пересекает нулевой уровень:
Adjust Selection Inward – границы выделенного фрагмента будут автоматически перемещены к нулевым точкам, расположенным внутри выделенного интервала.
Adjust Selection Outward – границы выделенного фрагмента будут автоматически перемещены к нулевым точкам, расположенным вне выделенного интервала.
Команды, позволяющие копировать, вырезать, удалять и вставлять материал, содержатся в меню Edit. Чтобы скопировать или вырезать фрагмент волновой формы, его нужно сначала выделить. 
При выполнении команд Copy (<Ctrl> + <С>) и Cut (<Ctrl> + <X>) данные будут помещены в текущий буфер обмена.
Команды Paste (<Ctrl> + <V>) и Paste to New обеспечивают вставку в волновую форму данных также из текущего буфера обмена. Начало вставляемого фрагмента будет совпадать с положением курсора.
Команда Paste to New представляет собой целую последовательность операций: сначала автоматически создается новая волновая форма, а потом из буфера обмена на нее вставляется фрагмент.
Команда Delete (<Del>) предназначена для удаления выделенного звукового блока.
Команда Crop (<Ctrl> + <T>), наоборот, удаляет из текущей волновой формы все звуковые данные, кроме выделенных. Оставшийся после удаления фрагмент будет по-прежнему выделен.
[image: ]Команда Edit > Mix Paste предназначена для наложения звуковых данных, хранящихся в буфере обмена, на редактируемую волновую форму. Команда Mix Paste открывает диалоговое окно, показанное на рисунке. 
В группе Volume расположены элементы управления громкостью вставляемого и замещаемого материала.
При установленном флажке Invert Copied Audio происходит инверсия волновой формы перед вставкой (положительные отсчеты колебаний превратятся в отрицательные, а отрицательные, наоборот, в положительные). Modulate – вставка с модуляцией по амплитуде. Каждый отсчет звукового сигнала из буфера умножается на соответствующий отсчет волновой формы.
5.2. Редактирование амплитуды
5.2.1. Усиление и ослабление амплитуды
Изменение амплитуды выделенного фрагмента и всех волновой формы возможно при помощи:
эффекта Amplify;
инструментов Fade и Heads-up Display в окне Editor; 
эффекта Volume Envelope;
[image: ]
Амплитуда сигнала на выделенном участке волновой формы преобразуется с помощью диалогового окна Amplify, открываемого командой Effects > Amplitude and Compression > Amplify. 
Коэффициент усиления задается с помощью регуляторов с именами каналов или численно в соответствующих полях ввода.
[image: ]Перемещая маркеры Fade In и Fade out (А), можно реализовать плавное усиление и ослабление амплитуды сигнала в начала и в конце волновой формы. Инструмент Heads-up Display (B) в окне Editor позволяет быстро изменить амплитуду сигнала при помощи регулятора Gain.
[image: ]Adobe Audition позволяет визуально задавать изменение амплитуды при помощи эффекта Effects > Amplitude and Compression > Volume Envelope. После вызова данного эффекта в окне Editor появляется огибающая громкости – сплошная желтая линия в верхней части окна. В окне эффекта установка флага Spline curves приводит к сглаживанию огибающей громкости.
[image: ]
Настройка формы огибающей производится при помощи мыши путем перемещения маркеров. Маркеры добавляются щелчком мыши по линии огибающей, а удаление – через команду контекстного меню маркера.
5.2.2. Создание тишины
Абсолютная тишина на выделенном участке волновой формы создается после применения команды Effects > Silence. Однако, хотя шум в паузах и должен быть ослаблен, полностью удалять его не следует. Скачки от идеально тихих фрагментов к фрагментам, где наряду с речью и музыкой содержится шум, бывают заметными и раздражают слушателя.
[image: ]В ряде ситуаций нужно "раздвинуть" отдельные фрагменты на определенный интервал, добавив между ними паузы заданной длительности. В таких случаях целесообразно воспользоваться командой Edit > Insert > Silence, открывающей окно Insert Silence, в котором есть поле для ввода длительности паузы. После нажатия кнопки Ok справа от курсора появится участок заданной длительности, содержащий абсолютную тишину. 
5.2.3. Нормализация
Нормализацию применяют для того, чтобы установить громкость волновой формы равной определенному уровню. 
[image: ]Диалоговое окно Normalize вызывается выбором команды Effects > Amplitude and Compression > Normalize.
В поле ввода Normalize to в процентах или децибелах задается уровень, к которому следует нормализовать волновую форму. Если установить в данное поле значение 100% (или 0 дБ) и выполнить нормализацию, то пиковая амплитуда достигнет максимально возможного уровня (0 дБ).
Если флажок Normalize All Channels Equally снят, то происходит раздельная нормализация всех стереоканалов. 
С помощью флажка DC Bias Adjust задается смещение сигнала относительно нулевого уровня. Нужно установить флажок DC Bias Adjust и задать значение, к которому необходимо привести средний уровень сигнала. 
Если звук записан со смещением или смещение возникло в результате применения эффектов, или сигнал содержит большую постоянную составляющую, или низкочастотные составляющие с большими амплитудами, то перед выполнением дальнейших преобразований нужно от этого избавиться, установив значение DC Bias Adjust = 0.
5.2.4. Инверсия
Инвертировать сигнал требуется тогда, когда при записи стерео файла нарушена фаза сигналов из-за ошибок коммутации или неверной распайки кабелей и разъемов. Сигналы правого и левого стереоканалов оказываются записанными в противофазе, а сама фонограмма становится мононесовместимой. 
Предварительно выделите тот фрагмент волновой формы, в котором звуковые волны требуется инвертировать. Затем выберите команду Effects > Invert.
Контрольные вопросы
1) Процесс удаления фрагмента волновой формы.
2) Редактирование амплитуды. 
3) Применение эффектов Fade in/out.
4) Создание тишины.
5) Нормализация.
6) Инверсия.
Задание
Привести в порядок структуру записанного материала, избавиться от неудачных дублей. 
Избавиться от смещения постоянного тока. 
Сформировать абсолютную тишину в необходимых участках фонограммы. 
Провести нормализацию волновой формы.
Внести в отчет описание и результаты работы по каждому применяемому инструменту шумоподавления.
Предоставить фонограмму до и после процесса редактирования.
[bookmark: _Toc345233626]6. частотная коррекция
6.1. Сущность и задачи частотной коррекции
Частотная коррекция – это процесс обработки звукового сигнала частотно-избирательными устройствами с целью изменения спектрального состава (тембра) сигнала. 
Задачами такой обработки могут быть:
амплитудно-частотная коррекция сигнала;
полное подавление спектра сигнала или шумов в определенной полосе частот;
улучшение разборчивости на речевом треке;
легкое изменения характера звука;
подчеркивание басового ритма в музыкальном фрагменте;
имитация телефонов, интеркомов и других реальных громкоговорящих устройств;
компенсация небольших недостатков системы воспроизведения.
Например, если микрофон, акустическая система или еще какой-либо элемент звукового тракта имеют неравномерную амплитудно-частотную характеристику, то эти неравномерности можно попробовать компенсировать.
Если в результате анализа спектра выяснилось, что энергия помех в основном сосредоточена в некотором диапазоне частот, а энергии полезного сигнала здесь совсем немного, то посредством фильтрации шумы в этом диапазоне частот можно подавить.
Есть определенные задачи, которые не могут быть решены при помощи фильтрации:
нельзя удалить нетональные шумы;
нельзя исправить искаженные записи;
нельзя создать звуки, которых раньше не было в записи (высокие частоты, которые были потеряны при низкочастотной дискретизации или басы, которые были раннее отфильтрованы);
нельзя выделить голос из толпы или исключить солиста или инструменты в оркестре.
6.2. Спектр
Спектр звукового сигнала является одним из важнейших инструментов анализа и обработки звука.
[image: ]Французский математик Фурье (1768-1830) и его последователи доказали, что любую периодическую функцию, в случае ее соответствия некоторым математическим условиям, можно разложить в ряд (сумму) косинусов и синусов с некоторыми коэффициентами, называемый тригонометрическим рядом Фурье.
[image: ]Любое, даже самое сложное по форме колебание (например, звук голоса человека), можно представить в виде суммы простейших синусоидальных колебаний определенных частот и амплитуд. На рисунке представлена волновая форма звука "и". 
Спектр в графическом представлении отображается в виде графика, в котором по оси абсцисс откладывается частота, а по оси ординат – амплитуда соответствующей частотной составляющей. На рисунке представлен спектр звука "и". 
6.3. Фильтры
Основным инструментом частотной коррекции являются фильтры (и инструменты, созданные на основе фильтров). Фильтр описывается амплитудно-частотными (АЧХ) и фазо-частотными характеристиками (ФЧХ). 
АЧХ представляет собой зависимость коэффициента передачи фильтра от частоты. Фильтрация сводится к умножению спектральных коэффициентов на соответствующие значения амплитудной характеристики фильтра.
Тот участок АЧХ, где коэффициент передачи не равен нулю, соответствует полосе пропускания фильтра. В полосе задерживания (или подавления), коэффициент передачи фильтра должен быть в идеальном случае нулевым.
6.3.1. Виды фильтров
В зависимости от вида полосы пропускания фильтры подразделяются на:
фильтры нижних частот (ФНЧ);
фильтры верхних частот (ФВЧ);
полосно-пропускающие (полосовые);
полосно-задерживающие (режекторные) фильтры.
Фильтры нижних и верхних частот характеризуются следующими основными параметрами:
[image: ]частотой среза; 
неравномерностью характеристики в полосе пропускания; 
крутизной ската характеристики в области перехода от полосы пропускания к полосе задерживания.
Теоретически идеальный ФВЧ (рисунок справа, верхний график) с частотой среза 1 кГц имел бы вертикальную линию на 1 кГц; частоты то 0 до 999 Гц находилась бы слева от нее и ослаблялась бы до бесконечности; частота 1001 Гц находились бы справа и вообще бы не затрагивались. 
Создать такой фильтр невозможно. [image: ]Реальные фильтры начинают работать постепенно, с плавным переходом между областями, где они не действуют на сигнал и где они уменьшают его, поэтому частоту среза определяют как точку, в которой сигнал уменьшается на 3 дБ.
На рисунке слева приведены графики АЧХ и ФЧХ фильтра нижних частот. 
Крутизна спада фильтра определяется как величина изменения коэффициента ослабления на частотах, отстоящих друг от друга на одну октаву (ед. изм. – дБ/октаву). Фильтр с крутизной 6 дБ на октаву называется фильтром первого порядка, 12 дБ на октаву – второго порядка и т.д. Примечание: частоты расположены с интервалом в одну октаву, если их отношение равно 2:1. 
[image: ]Полоса пропускания полосно-пропускающих фильтров (рисунок слева) определяется как диапазон частот, в котором усиление находится в пределах 3 дБ от максимума. 
[image: ]Полоса подавления режекторных фильтров (рисунок справа) определяется как диапазон частот, в котором ослабление находится в пределах 3 дБ от максимума. 
Середина полосы пропускания называется центральной частотой. 
Коэффициент усиления (ослабления) полосно-пропускающих (режекторных) фильтров задает величину усиления (подавления) на центральной частоте. 
6.3.2. Добротность полосового фильтра
[image: ]Часто вместо полосы пропускания используется понятие добротности (обозначается Q), вычисляемое как отношение центральной частоты к ширине полосы пропускания. На рисунке представлены два режекторных фильтра с одинаковой центральной частотой и разными добротностями 
Q = 2.8, Q = 25. 
При Q ≥ 15 можно точно удалить синусоидальный сигнал постоянной частоты без заметного воздействия на окружающие частоты. 
У некоторых специализированных фильтров добротность может достигать нескольких тысяч (в Adobe Audition – 3000).
6.3.3. Фазо-частотная характеристика
ФЧХ фильтра показывает, как меняется фаза сигнала. Если фаза меняется на величину, пропорциональную частоте, то это соответствует простому сдвигу сигнала во времени, без изменения его формы.
ФЧХ важна, так как сигнал, прошедший через фильтр без изменения амплитуды в полосе пропускания, может быть искажен по форме, если временное запаздывание при прохождении через фильтр не будет постоянным для разных частот. 
Одинаковое время задержки соответствует линейной зависимости фазы от частоты. Для ФНЧ и ФВЧ зависимость фазы от частоты можно считать линейной лишь в окрестностях частот среза, а для полосового фильтра – в окрестностях центральной частоты. Фильтрация звука в широкой полосе будет обязательно сопровождаться фазовыми искажениями, приводящими к изменению формы сигнала.
6.4. Эквалайзеры
Эквалайзеры (equalizer, EQ) представляют собой устройства, объединяющие в себе несколько фильтров, предназначенные для частотной коррекции сигнала. 
По типу управления частотной характеристикой различают:
графический эквалайзер; 
параметрический эквалайзер.
6.4.1. Графический эквалайзер
Графический эквалайзер – это набор полосовых фильтров с фиксированными центральными частотами, фиксированной добротностью и переменным коэффициентом усиления, которым можно управлять при помощи слайдера. 
В качестве регуляторов принято использовать именно слайдеры, так как положение их ручек представляет собой некое подобие графика АЧХ эквалайзера. На вход всех фильтров подается один и тот же сигнал, и задача каждого фильтра состоит в том, чтобы усилить или ослабить свой участок спектра в соответствии с коэффициентом усиления.
Частоты, на которых осуществляется регулирование в графических эквалайзерах, унифицированы и выбираются из ряда стандартных частот, перекрывающих весь звуковой диапазон, и отстоящих друг от друга на некоторый интервал. Этот интервал может составлять октаву, ее половину, или треть октавы (таким образом, получаем десяти, двадцати и тридцати полосные эквалайзеры).
Наиболее часто графические эквалайзеры применяются для итоговой обработки сигнала. С помощью графического эквалайзера можно приближенно сформировать необходимую АЧХ системы обработки звука или акустической системы: поднять усиление в одних областях частот и уменьшить его в других. 
Графический эквалайзер малопригоден для точной частотной коррекции, так как центральные частоты фильтров неизменны. Они могут не совпадать с теми частотами, на которых следует усилить или ослабить спектральные составляющие.
6.4.2. Параметрический эквалайзер
Параметрический эквалайзер позволяет управлять не только коэффициентом усиления фильтра, но и его центральной частотой, а также добротностью. 
При помощи параметрического эквалайзера можно точно устанавливать значения этих параметров таким образом, чтобы, например, подчеркнуть звук отдельного инструмента или удалить нежелательную помеху (например, фон 50 Гц) с минимальным влиянием на остальные элементы звукового образа.
Для формирования АЧХ сложного вида применяются многополосные параметрические эквалайзеры, параметры каждого из которых можно изменять независимо.
6.5. Инструменты частотной коррекции Adobe Audition
6.5.1. Инструмент FTT Filter
[image: ]Команда Effects > Filter and EQ> FFT Filter открывает окно эквалайзера, АЧХ которого пользователь может создать самостоятельно.
Основным элементом окна является координатное поле, на котором отображается амплитудно-частотная характеристика фильтра. По горизонтальной оси откладываются значения частоты, а по вертикальной — коэффициент передачи фильтра для каждого значения частоты. Флажок Spline Curves позволяет включить сплайн-аппроксимацию графика, тогда АЧХ фильтра будет сглажена.
6.5.2. Инструмент Graphic Equalizer
[image: ]Многополосный графический эквалайзер представлен в трех вариантах:
10-полосный эквалайзер; 
20-полосный эквалайзер; 
30-полосный эквалайзер.
Слайдерами можно изменять уровень сигнала на той или иной частоте. Приближенное значение центральной частоты настройки конкретного элементарного фильтра указано над регулятором. 
Примечание: для крайних слева и справа регуляторов указаны не центральные частоты, а частоты среза фильтров.
6.5.3. Параметрический эквалайзер
Команда Effects > Filtres > Parametric Equalizer отображает семиполосный параметрический эквалайзер, позволяющий с высокой точностью задать практически любую форму АЧХ фильтра.
В отличие от графического эквалайзера, который имеет фиксированное количество полос с заданными центральными частотами и добротностью, параметрический эквалайзер обеспечивает возможность произвольной настройки частоты, добротности и коэффициента усиления.
График АЧХ фильтра может настраиваться:
1) путем изменения значений элементов управления данного эффекта; 
2) перетаскиванием контрольных точек графика.
Параметрический эквалайзер содержит девять секций:
пять секций полосовых фильтров (обозначены цифрами от 1 до 5);
секция нижнего полочного эквалайзера (L, low shelf);
секция верхнего полочного эквалайзера (H, high shelf);
фильтр верхних частот (HP, high pass);
фильтр низких частот (LP, low pass).
[image: ]
Для полосовых фильтров задаются параметры:
центральная частота (Frequency);
коэффициент усиления/ослабления (Gain);
добротность (Q) или ширина полосы пропускания (Width).
Для секций полочного эквалайзера задается:
частота среза (Frequency);
коэффициент усиления/ослабления (Gain);
первый или второй порядок эквалайзера.
Для фильтров верхних и нижних частот задается:
частота среза (Frequency);
крутизна спада (выпадающий список, 6..48dB/Oct).
6.6. Многополосный режекторный фильтр
Режекторный фильтр, окно которого открывается командой Effects > Noise Reduction > DeHummer, предназначен для подавления нежелательных узкополосных составляющих в спектре сигнала. Он особенно полезен для подавления фоновых составляющих с частотой промышленной электрической сети (50 Гц) и гармоник этой частоты (для этого следует выбрать шаблон Remove 50Hz and Harmonics).
[image: ]Верхняя часть окна – амплитудно-частотная характеристика многополосного режекторного фильтра. Для фильтра можно задавать следующие параметры:
частота первой полосы (Base Frequency);
добротность (Q);
коэффициент ослабления (Gain);
количество полос (Number of Harmonics);
коэффициент уменьшения параметра Gain (Harmonic Slope). 
Первый два параметра могут изменяться при помощи мыши на графике.
6.7. Настройка фильтров и эквалайзеров
6.7.1. Настройка фильтров
Фильтр нижних частот может применяться для удаления высокочастотного шипения. Фильтр верхних частот может применяться для удаления низкочастотного гула.
Настройка фильтров состоит из двух этапов:
настройка частоты среза;
выбор порядка фильтра.
Для удаления низкочастотного гула следует постепенно увеличивать частоту среза (начальное значение – 0 Гц), пока низкочастотный гул не исчезнет (и при этом не будет затронут полезный сигнал).
Для удаления высокочастотного шипения следует постепенно уменьшать частоту среза (начальное значение – 20 кГц), пока шипение не исчезнет (и при этом не будет затронут полезный сигнал).
Чем больше порядок фильтра, тем быстрее происходит переход от полосы задерживания к полосе пропускания, но тем больше будут фазовые искажения.
6.7.2. Настройка параметрического эквалайзера
При настройке параметрического эквалайзера для исключения шума следует выполнить следующие шаги:
1. Установить максимальное значение Q и усиления.
2. Запустить воспроизведение. Во время воспроизведения медленно изменять частоту, пока не будет услышан внезапный скачок шума. Затем медленно изменять частоту, пока не возникнет сильный резонанс шума.
3. Не изменяя Q и частоту, переместите boost/cut (усиление/ослабление) до упора в сторону уменьшения. Шум должен исчезнуть.
Если шум не исчезнет полностью, следует немного уменьшить величину Q. Если это не помогает, то увеличить Q обратно, добавить еще одну секцию и произвести поиск частоты, в два раза более высокой, чем первая.
6.7.3. Примеры использования фильтров и эквалайзеров
Большинство решений опирается на параметрический эквалайзер. Решение описывается в виде: частота/усиление/Q. Например, 1 кГц/-3 дБ/Q=0.5 означает, что частота установлена на 1 кГц, а уровень усиления на -3 dB, Q = 0.5.

1. Так как в области около 1.75 кГц находятся основные гармоники большинства согласных звуков, то усиление 1.75 кГц/+3 дБ/Q=1 может тонко улучшить разборчивость, 1.75 кГц/+6 дБ/Q=0.5 может добавить силы некоторым голосам.
2. На октаву выше располагается первая гармоника большинства согласных звуков: 3.5 кГц/+3 дБ/Q=1 может добавить чистоты звучанию.
3. Мужские голоса могут получить немного дополнительной силы при 160 Гц/+2 дБ/ Q=1.
4. Часто между 4 кГц и 5 кГц возникает шепелявость (шипящие звуки). Поищите их в этой области при /+12дБ/Q=5, пока не найдете, а затем сделайте максимально возможный провал. 
5. Многие записи при съемке в помещении являются гулкими в районе 200..400 Гц, в зависимости от размеров помещения. Может помочь провал 3 дБ/Q=2, но вначале следует найти точное значение частоты. 
6. Если звуки речи являются тусклыми из-за плохой работы с микрофоном, попробуйте 4 кГц/+6 дБ/Q=0.25. 
7. Резкие звуки /п/ и /б/ иногда могут быть устранены выделением и применением крутого ФВЧ около 160 Гц.
8. Записи современной поп-музыки часто являются слишком яркими, с большой активностью выше 10 кГц. Если нужно их сводить с более старыми записями, попробуйте полочный эквалайзер на 10 кГц/-3 дБ. Затем добавьте 5 кГц/+3дБ/Q=0.5 к старому материалу.
9. Для подавления низкочастотного шума в речи попробуйте крутой ФВЧ примерно от 130 Гц (для мужского голоса) до 200 Гц (для женского голоса).
10. Для подавления высокочастотного шума в речи или музыке попробуйте крутой ФНЧ примерно на 8 кГц.
11. Так называемый 50-герцовый шум может иметь гармоники по всему диапазону. Начните с крутого ФВЧ на 130 Гц и затем добавьте не менее четырех-пяти параметрических секций, настроенных на гармоники на слух. Если после этих исправлений трек станет звучать слишком тускло, добавьте +3 дБ/Q=1 на частоте примерно в 1.5 раза выше частоты ФВЧ.
12. Для имитации телефона используйте крутой ФВЧ на 400 Гц с последующим крутым ФНЧ на 3,5 кГц.
13. Для громкоговорителя радио, в зависимости от его качества, используйте ФВЧ на 300..500 Гц, а затем добавьте ФНЧ на 
5..6 кГц. 
14. Тонкий голос, напоминающий старое радио и используемый во многих современных радиорекламах, может быть создан с помощью ФВЧ на 800 Гц и ФНЧ на 10 кГц.
15. Перенос голосов в соседнее помещение может осуществляться с помощью низкочастотного полочного эквалайзера примерно с 500 Гц/-24 дБ, резонансного пика примерно с 1,3 кГц/+12 дБ/Q=5 и высокочастотного полочного эквалайзера 2 кГц/-24 дБ. 
16. Внешние звуки можно сделать более отдаленными, уменьшая высокие и акцентируя низкие. Задайте полочный эквалайзер на низкий частотах 500 Гц/+12 дБ, и на верхних частотах: 
1,5 кГц/-12 дБ. Затем уменьшите общую громкость.
17. Для «обесчеловечивания» голоса при создании звуковых эффектов начните с вырезания гласных формант с помощью крутого параметрического эквалайзера. В зависимости от гласного звука вы найдете их около 400 Гц, 800 Гц, 1,2 кГц, 1,6 кГц, 2 кГц, 2,4 кГц, 2,8 кГц, 3,2 кГц, 3,6 кГц и 4 кГц.
Контрольные вопросы
1. Сущность и задачи частотной коррекции.
2. Спектр.
3. Фильтры. Виды фильтров.
4. Частота среза. Порядок фильтра. 
5. Полоса пропускания. Центральная частота. Добротность.
6. Фазо-частотная характеристика.
7. Эквалайзеры. Графический эквалайзер. Параметрический эквалайзер.
8. Настройка фильтров.
9. Настройка параметрического эквалайзера.
Задание
Проанализировать записи на наличие шумов, которые могут быть исправлены при помощи механизма частотной коррекции:
низкочастотный гул;
высокочастотное шипение;
шумы оборудования;
наводки от сети переменного тока;
прочие тональные шумы.
Определить алгоритм обработки записи. Обоснованно применить инструменты фильтрации. Применить графический эквалайзер для окончательной настройки звучания треков.
Внести в отчет описание и результаты работы по каждому при-меняемому инструменту частотной коррекции. Предоставить фонограмму до и после процесса частотной коррекции.
[bookmark: _Toc345233627]7. динамическая обработка
7.1. Основные понятия
Динамическая обработка звука – это обработка, которая приводит к изменению динамического диапазона фонограммы.
Под динамическим диапазоном фонограммы понимают отношение максимального и минимального уровней громкости (maximum, minimum RMS power).
Из всех процессов, используемых в создании музыки, динамическая обработка звука является, пожалуй, наиболее сложной для восприятия. В первую очередь это связано с тем, что зачастую результат обработки звука едва различим на слух – особенно для начинающих. Другая трудность заключается в количестве изменяемых параметров: их не так мало, и к тому же, изменение каждого из них не всегда приводит к очевидным результатам.
Любой инструмент динамической обработки имеет три функциональных элемента:
основной канал;
детектор огибающей;
контроллер громкости.
Задачи детектора огибающей – обнаружить момент пересечения аудио сигналом из основного канала порогового значения и измерить уровень аудио сигнала относительно данного порогового значения.
Задача контроллера громкости – выработать управляющее воздействие на основной канал в зависимости от измеренной величины аудио сигнала.
В зависимости от параметров контроллера громкости и детектора огибающей, различают следующие инструменты динамической обработки:
компрессор;
ограничитель уровня;
автостабилизатор уровня;
экспандер;
компандерный и пороговый шумоподавители;
устройства со сложным преобразованием динамического диапазона.
7.1. Компрессор
Компрессор - это инструмент динамической обработки, который сужает динамический диапазон сигнала и, благодаря этому, уменьшает разницу в уровне громкости между тихими и громкими звуками. 
[image: Wave_post_com][image: Wave_pre_comp]С помощью компрессора можно добиться более плотного и отчётливого звучания.
Результат динамической обработки зависит от правильного выбора значений нескольких основных параметров. К важнейшим из них относятся:
порог срабатывания (threshold);
коэффициент компрессии (ratio);
компенсирующее усиление (makeup gain);
время атаки (attack time);
время восстановления (release time).
7.2.1. Порог срабатывания
[image: ]Порог срабатывания задает уровень громкости, при превышении которого начинается управление усилением. 
[image: ]До тех пор, пока значение уровня сигнала меньше порогового, обработка не воздействует на сигнал. От величины порога зависит, коснется ли обработка только отдельных пиков, или сигнал будет подвергаться обработке постоянно. Если вы установите порог на 0 дБ, то динамической обработки происходить не будет.
Красная линия на рисунке представляет собой порог (threshold control). Сигналы №1 и №3 громче порога, поэтому они сжимаются. Сигналы №2 и №4 ниже порога, не изменяются. 
Кроме того, относительные громкости сигналов не изменяются.
7.2.2. Коэффициент компрессии
Коэффициент компрессии определяет степень сжатия динамического диапазона сигнала, имеющего уровень выше порогового. 
Например, коэффициент компрессии 2:1 означает, что превышение входным сигналом порога на 2 дБ вызовет превышение порога выходным сигналом на 1 дБ. Абсолютному ограничению соответствует коэффициент компрессии "∞ : 1", но на практике величины отношений больше, чем 20:1, дают такой же эффект.
Чем больше коэффициент компрессии, тем меньше будет динамический диапазон сигнала. При коэффициенте сжатия 1:1 компрессии не будет вообще.
7.2.3. Компенсирующее усиление
Компенсирующее усиление (makeup gain) необходимо для того, чтобы усилить сигнал, который был ослаблен при выполнении динамической обработки. Чем больше степень сжатия, тем больше должно быть компенсирующее усиление.
 [image: ] [image: ] [image: ] [image: ]
На рисунке приведена исходная запись и пример использования компрессии со степенью сжатия 2:1, 4:1, 8:1. 
Красная линия обозначает максимальный уровень громкости первого сигнала. Длина зеленой стрелки обозначает величину компенсирующего усиления, которое должно быть задано для того, чтобы после компресии максимальный уровень громкости после компресии довести до максимального уровень громкости до компрессии.
7.2.4. Время атаки и время восстановления
[image: Fruity_compressor_wave]Оценку инерционности устройств динамической обработки осуществляют на основе анализа двух временных характеристик: времени атаки (attack time, время реакция устройства на увеличение уровня сигнала) и времени восстановления (release time, время реакция устройства на уменьшение уровня сигнала). 
При больших значениях параметра attack time невозможно отслеживать резкие увеличения уровня входного сигнала, в результате в выходном сигнале будут присутствовать пики.
[image: ]Медленная атака менее склонна к искажениям, но неспособна реагировать на быстрые звуки. Если значение параметра attack time мало, то можно практически исключить возникновение пиков сигнала при скачкообразном увеличении его уровня. Быстрая атака может регулировать резкие переходы звука, но может вызывать искажения.
На рисунке продемонстрировано использование различных значений времени атаки. Первая огибающая является исходным сигналом, синусоидальной волной 1 кГц на -6 дБ, длительностью полсекунды. 
[image: Fruity_compressor_wave_release]Три другие огибающие получены на выходе компрессора с порогом -20 дБ и степенью сжатия 10:1. Для второй огибающей время атаки компрессора равняется 0,05 мсек. Для третьей огибающей использовалось время атаки 1 мсек. Для четвертой огибающей использовалось время атаки 100 мсек.
Время восстановления — это время, за которое устройство динамической обработки выходит из активного состояния после падения уровня сигнала ниже порогового. 
Если время восстановления слишком велико, то компрессор дольше находится в активном состоянии и воздействует на динамический диапазон даже тогда, когда это нежелательно. 
7.3. Амплитудная характеристика инструментов динамической обработки
[image: ]Для отображения всех параметров инструмента динамической обработки (за исключением времени атаки и времени восстановления) может быть использован график, представляющий зависимость уровня выходного сигнала (вертикальная ось) от уровня входного сигнала (горизонтальная ось).
Линия, выходящая из левого нижнего в правый верхний угол, соответствует коэффициенту сжатия 1:1.
Порог (обведен красным цветом) установлен на -20dB.
Степень сжатия может быть рассчитана по углу наклона части графика (обведено зеленым цветом): при изменении сигнала на 20дБ (по горизонтали) выходной сигнал изменится на 10дБ (по вертикали). Таким образом, степень сжатия для данного графика равна 2:1.
[image: ]На рисунке слева представлен график более сложного инструмента динамической обработки, сочетающий в себе одновременно компрессор и экспандер.
От первого порога -40dB до 0dB данное устройство работает как компрессор со степенью сжатия 4:1 (Участок 1). 
От второго порога (-70dB) до первого – как экспандер, степень сжатия 1:1.77 (Участок 2). 
Ниже второго порога степень сжатия 1:1 (Участок 3). Максимальный уровень выходного сигнала будет равен -5дБ.

7.4. Экспандер, гейт, лимитер
[image: ]Экспандер динамического диапазона применяют в том случае, когда необходимо расширить динамический диапазон сигнала. 
Экспандер имеет два порога, при этом обработка происходит между этими двумя порогами. 
[image: ]Пороговый шумоподавитель (noise gate, гейт, gate) — предназначен для подавления сигнала, который находится в заданном динамическом диапазоне. 
[image: ]Однопороговый гейт начинает попускать сигнал (происходит открытие гейта), как только происходит превышение порога уровнем сигнала, и задерживает сигнал (гейт закрывается), как только уровень сигнала становился бы меньше порога. 
Двухпороговый гейт (верхний порог GateOpen, нижний порог GateClose) включается, когда уровень сигнала превысит верхний порог, а выключается только после того, как уровень сигнала станет меньше нижнего порога.
[image: ]Лимитер (limiter, ограничитель уровня) - ограничитель динамического диапазона. В большинстве случаев используется для предотвращения перегрузки (клипирования) и подавления кратковременных всплесков громкости (пиков), при выравнивании динамики сигнала. В последовательности эффектов лимитер обычно стоит последним.
7.5. Инструменты динамической обработки Adobe Audition
В составе Adobe Audition имеются следующие инструменты динамической обработки:
Dynamics Processing – универсальная динамическая обработка; 
Hard Limiting – ограничитель уровня;
Single-band compressor – однополосный компрессор;
Tube-modeled compressor – инструмент, эмулирующий старые аппаратные устройства-компрессоры;
Multiband compressor – многополосный компрессор..
7.5.1. Универсальная динамическая обработка
Диалоговое окно Dynamics Processing открывается командой Effects > Amplitude And Compression > Dynamics Processing. 
В зависимости от выбранных значений параметров данный эффект может выполнять функции гейта, компрессора, экспандера, лимитера и т.д. Вид обработки и значения параметров можно задавать как графическим путем, так и численно.
[image: ][image: ]
Диалоговое окно содержит две вкладки:
Dynamics – позволяет задавать в графическом виде амплитудную характеристику;
Settings – позволяет настраивать параметры детектора огибающей, процессора усиления и полосы пропускания.
График амплитудной характеристики редактируется путем задания пороговых точек (добавление – щелчок мышью, удаление и точная настройка – через контекстное меню точки). Информация о сегментах (значение порога, коэффициент и тип обработки отображается в списке под графиком).
Флаг Spline Curves включает режим сглаживания графика.
Параметр Make-Up Gain задает величину компенсирующего усиления.
В поле Lookahead Time следует задать временной интервал, на который включение устройства динамической обработки должно опережать появление резкого перепада уровня сигнала.
В группе Level Detector задаются параметры детектора огибающей, в задачи которого входит определение уровня громкости входного сигнала:
Input Gain – коэффициент усиления на входе детектора огибающей;
Attack Time – время атаки;
Release Time – время восстановления.
С помощью переключателей Peak и RMS вы можете выбрать вид амплитудного детектора — пиковый (нежелательно) или среднеквадратический (рекомендуется).
В группе Gain Processor задаются параметры контроллера громкости:
Output Gain – коэффициент усиления на выходе;
Attack Time – времени атаки;
Release Time – времени восстановления;
Контроллер громкости ослабляет или усиливает сигнал в зависимости от амплитуды, которую определил Level Detector.
В группе Band Limiting можно задать нижнюю (Low Cutoff) и верхнюю (High Cutoff) граничные частоты обрабатываемого диапазона. Опции данной группы позволяют подвергать динамической обработке не весь сигнал, а только его отдельные спектральные составляющие. Например, можно задать диапазон от 4352 Гц до 13060 Гц для динамической обработки свистящих звуков в речи человека. Так реализован виртуальный диэсер (DeEsser).
7.5.2. Ограничитель уровня
Команда Effects > Amplitude and Compression > Hard Limiting открывает диалоговое окно Hard Limiting, с помощью которого можно уменьшать до заданного уровня амплитуду звуковых колебаний при условии превышения ею некоторого порога. Амплитуда всех звуковых отсчетов, находящихся ниже этого порога остается неизменной.
[image: ]В поле Maximum Amplitude задается максимальная допустимая амплитуда волновой формы. Для звука с разрядностью 16 бит рекомендуется устанавливать значение -0.3 дБ.
Перед выполнением ограничения звук может быть предварительно усилен. В поле ввода Input Boost задается величина предварительного усиления.
В поле Look-Ahead Time нужно задать время упреждения срабатывания ограничителя при появлении пика сигнала. Если значение этого параметра слишком мало, могут появиться слышимые искажения. Рекомендуются значения 4..10 мс.
В поле Release Time указывают время, необходимое для восстановления нормального уровня звука после обработки чрезвычайно громкого пика. Для сохранения низкочастотного баса рекомендуется установить значение параметра равным 100 мс.
7.5.3. Компрессор
[image: ]Классический однополосный компрессор реализует эффект Single-band Compressor. Все параметры задаются при помощи слайдеров:
порог компрессии (threshold);
коэффициент сжатия (ratio);
время атаки (attack);
время восстановления (release);
компенсирующее усиление (output gain).
Эффект Amplitude And Compression > Tube-modeled Compressor имитирует колорит устаревших аппаратных ламповых компрессоров. 
[image: ]Использовать данных эффект можно для того, чтобы добавить (едва заметное) искажение типа distortion, которое придаст звуку «приятную окраску». Параметры данного эффекта полностью аналогичны настройкам любого другого компрессора. 
7.5.4. Многополосный компрессор
Эффект Amplitude and Compression > Multiband Compressor позволяет производить независимую компрессию в четырех различных частотных диапазонах. Так как динамика звука для каждого частотного диапазонах уникальна, то данный эффект является мощным средством для сведения звука.
Элементы управления данного эффекта (crossover: low, mid, high) позволяют задать частоты для кроссовера для разделения звукового сигнала, чтобы затем применить к каждой отдельной полосе собственные параметры компрессии. 
Кнопки Solo (S) позволяют прослушивать полосы по-отдельности, кнопки Bypass (B) позволяют отключить обработку звука в конкретной полосе частот.
[image: ef18]Элементы управления кроссовера:
A. Частотные диапазоны.
B. Маркер кроссовера.
C. Полоса частот, которая не обрабатывается
D. Шкала громкости.
E. Шкала частот.
Элементы управления полосой компрессора:
A. Кнопка Solo
B. Кнопка Bypass
C. Настройка порогового уровня
D. Индикаторы громкости 
E. Индикатор компрессии (ослабления громкости)
[image: ef19]Индикатор Gain Reduction измеряет уровень ослабления сигнала. Чем выше уровень на индикаторе, тем меньше ослабление, которому подвергается сигнал в результате компрессии. Слайдер С (Threshold) предназначен для настройки порогового уровня, с которого начинается компрессия.
Для компрессии только пиков и большего сохранения динамического диапазона рекомендуется устанавливать порог на 5 дБ ниже максимального уровня громкости; для большей компрессии и большего уменьшения динамического диапазона – на 15 дБ ниже уровня пиков. 
Параметр Gain представляет собой настройку компенсирующего усиления. Диапазон возможных значений: от -18 дБ до +18 дБ. Параметр Ratio устанавливает коэффициент компрессии (от 1:1 до 30:1). Параметр Attack задает время атаки в милисекундах (от 0 до 500 мсек). Параметр Release задает время восстановления (от 0 до 5000 мсек). Параметр Output Gain позволяет усиливать или ослаблять результирующий сигнал. 
Limiter – ограничитель уровня – применяется к результирующему сигналу после общего усиления.
Контрольные вопросы
1. Динамическая обработка звука. Динамический диапазон.
2. Компрессор. 
3. Порог срабатывания. Коэффициент компрессии. Компенсирующее усиление. 
4. Время атаки. Время восстановления.
5. Амплитудная характеристика инструмента динамической обработки.
6. Экспандер. Лимитер. Гейт.
Задание
Проанализировать запись с точки зрения применения инструментов динамической обработки. По необходимости применить: компрессор, гейт, диэссер, лимитер.
Внести в отчет описание и результаты работы по каждому при-меняемому инструменту динамической обработки. Предоставить фонограмму до и после процесса обработки.
[bookmark: _Toc345233628]
8. применение Эффектов
В данной теме расматриваются эффекты, различные как по принципу действия, так и по тем задачам, которые данные эффекты призваны решить при обработке звука.
Для большинства эффектов присутствуют следующие настройки:
коэффициент, задающий пропорции смешивания обработанного эффектом (Wet Out) и исходного (Dry Out) сигналов;
коэффициент (регулятор глубины) обратной связи (Feedback). При обратной связи сигнал с выхода эффекта опять подается в линию обработки.
8.1. Эффекты дилей и эхо
Эффект дилей (задержка, delay) заключается в том, что исходный сигнал смешивается со своей копией (или несколькими копиями), задержанными на определенное время.
Данный эффект может применяться для получения эффекта однократного или многократного повторения каких-либо звуков. 
[image: ]Для того, чтобы при прослушивании исходный сигнал и задержанный сигнал были различимы, следует задавать время задержки не менее 35мсек.

Команда Effects > Delay and Echo > Delay открывает диалоговое окно эффекта Delay.
В группах Left Channel и Right Channel находятся элементы настройки времени задержки для каждого стереоканала.
С помощью регулятора Delay Time или непосредственно в поле ввода, расположенном справа от него, вы можете задать время задержки (единица измерения времени выбирается в поле Delay Time Units). 
Состояние флажка Invert определяет, будет ли подмешиваемый сигнал инвертирован по фазе. 

Команда Effects > Delay and Echo > Analog Delay открывает диалоговое окно эффекта Analog Delay. Данный эффект моделирует звучание устаревших аппаратных устройств. 
[image: ]Параметр Mode задает тип моделируемого устройства, что, в свою очередь, определяет параметры эквализации и искажающего эффекта. Режимы Tape и Tape/Tube соответствуют по характеристикам старым ленточным и ламповым устройствам создающим эффект дилей, режим Analog – более поздним электронным устройствам.
Параметр Trash – увеличивает искажения, а также усиливает нижние частоты, Spread – задает ширину стереопанорамы.

Основное отличие эффекта эхо (echo) от эффекта дилей состоит в том, что задержанные копии сигнала подвергаются дополнительной обработке — изменяется их спектр. Звук, обработанный эффектом эхо, имеет более натуральное звучание. 
В природе эхо образуется в результате отражения звуковых волн от препятствий (домов, стен помещения, гор и т. п.). Различные спектральные составляющие звука по-разному отражаются от препятствий. Чем ниже частота, тем легче волна преодолевает препятствия. Высокочастотная волна не проходит сквозь препятствие, а отражается от него и частично поглощается. Кроме того, высокочастотные звуковые волны при распространении в воздухе затухают быстрее низкочастотных.
Таким образом, эхо содержит смещенный во времени исходный сигнал, у которого будут ослаблены и низкие, и высокие частоты. Как именно они изменятся — зависит уже от конкретных условий распространения звука (расстояние до препятствия, его материал и т. п.).
С помощью диалогового окна эффекта Effects > Delay and Echo > Echo можно смоделировать описанные ранее условия . 
Регулятор Delay Time задает время, на которое будет задержан сигнал. Регулятор Feedback задает глубину обратной связи. Регулятор Echo Level задает уровень, с которым эхо будет подмешиваться к исходному сигналу.
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Группа Successive Echo Equalization представляет собой эквалайзер, с помощью которого можно изменять спектр задержанного сигнала.
8.2. Эффекты модуляции
В основу эффектов хор (chorus), фленжер (flanger) и фэйзер (phaser) также положена задержка сигнала с частотной или фазовой модуляцией. 
Модуляцией называется периодическое изменение некоторого параметра сигнала (частоты, фазы, амплитуды). Периодичность изменения задается частотой и амплитудой модуляции.
8.2.1. Хор
Хор (chorus) – эффект исполнения одного и того же звука не единственным инструментом или певцом, а несколькими. С одной стороны, голоса певцов и звуки инструментов при исполнении одинаковой ноты должны звучать одинаково, и к этому стремятся и музыканты, и дирижер. Но из-за индивидуальных различий источников звук все равно получается разным. В пространстве эти слегка неодинаковые колебания взаимодействуют и образуются так называемые биения, которые обогащают спектр звука.
Алгоритм моделирования эффекта хора:
исходный сигнал разделяется на два или несколько каналов;
в каждом из каналов спектр сигнала сдвигают по частоте на определенную для каждого канала величину (частотные сдвиги составляют доли герца);
сигналы, полученные таким способом, складывают.
Хор – это один из способов создания эффекта присутствия, т. е. выделения голоса певца или звука инструмента на фоне аккомпанемента. Эффект хор также используется, чтобы создать эффект псевдостереофонического звучания моно аудиофайла или обогатить вокальную партию. 
Вместе с тем, не следует чрезмерно увлекаться этим эффектом, так как это может привести к ухудшению разборчивости звучания голоса.
Команда Effects > Modulation > Chorus открывает диалоговое окно эффекта хора.
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В поле Voices указывается количество голосов, участвующих в формировании эффекта. 
Delay Time – максимальное временное рассогласование голосов (рекомендуется устанавливать в пределах 15..35 мс). Если установлено маленькое значение, то голоса начнут объединяться в один, и может возникнуть неестественный эффект, напоминающий Flanger. При слишком больших значениях параметра вам может показаться, что запись воспроизводится магнитофоном, который начал "зажевывать" ленту.
Spread – дополнительная задержка каждого голоса (до 200 мс). При больших значениях этого параметра отдельные голоса начинают звучать в разное время. Малые значения дополнительной задержки придают эффекту характер унисона нескольких голосов.
Параметр Modulation Depth задает глубина вибрато (амплитуду модуляции по частоте), а Modulation Rate – частоту модуляции.
Параметр StereoField предназначен для выбора протяженности эффекта на стереопанораме. Если введено значение 0, все голоса будут помещены в центр стерео-панорамы. При установке ползунка в положение 50% все голоса расположатся на панораме равномерно слева направо.Если выбирать значения больше 50%, то по мере перемещения ползунка вправо голоса начнут перемещаться к крайним точкам панорамы: "левые" голоса переместятся еще левее, а "правые" – правее. Если ползунок находится в положении Wide (значение параметра составляет 100%), все левые голоса помещены в крайнюю левую точку, правые – в крайнюю правую точку.
8.2.2. Фленжер и фэйзер 
Флэнжер отличается от фейзера тем, что для первого эффекта времена задержек копий и изменение частот сигнала значительно большее, чем для второго. 
Значения времен задержек, характерные для флэнжера, существенно превышают период звукового колебания. Если величина задержки меньше периода колебания, принято говорить уже не о задержке копий сигнала во времени, а о разности их фаз. Если эта разность фаз не остается постоянной, а изменяется по периодическому закону, то получается эффект фэйзер.
[image: ]Количественные отличия эффектов приводят к отличиям качественным: звуки, обработанные ими, приобретают различные акустические и музыкальные свойства.
Диалоговое окно эффекта Flanger открывается командой Effects > Modulation > Flanger.
Регуляторы Initial Delay Time и Final Delay Time соответственно задают начальное и конечное запаздывание "плывущего" звука за один полупериод модуляции. 
Звуки левого и правого стереоканалов могут задерживаться по-разному. Параметр Stereo phasing задает разность фаз для стереоканалов.
Регулятор Modulation Rate задает частоту модуляции.
Диалоговое окно Phaser открывается командой Effects > Modulation > Phaser. Данный эффект может применяться для создания нереальных звуковых эффектов.
В Adobe Audition эффект реализован следующим образом: имеется группа фильтров, которые сдвигают фазу сигнала до и после частоты среза. При применнии эффекта фильтры периодически переключаются.
Параметр фэйзера:
[image: ]Stages – количество фильтров, сдвигающих фазу;
Intensity – процент применения эффекта;
Depth – глубина модуляции;
Mod Rate – частота модуляции;
Phase Diff – задает разность фаз стереоканалов.
Upper Freq – задает верхнюю частоту среза для фильтров.
Output Gain – величина усиления после применения эффекта.
8.2. Реверберация
8.2.1. Распространение звука в замкнутом простанстве
Распространение звуковых волн в замкнутом пространстве отличается от распространения звука в открытом пространстве.
Попадая на поверхность, звуковая волна:
частично отражается от поверхности, 
частично поглощается материалом поверхности, переходя в тепловую энергию; 
незначительная ее доля проходит в соседнее помещение или пространство. 
Какая именно часть энергии отражается обратно в помещение, определяет коэффициент отражения поверхности. Степень поглощения определяет коэффициент поглощения. Относительная мощность волны, прошедшей сквозь поверхность, задает коэффициент звукопроводности.
[image: ]Рассмотрим пример: в комнате создается короткий акустический сигнал.
1. Первым в точку приему Пр придет прямой звук выстрела. 
2. Звуковые волны устремятся полу, потолку, стенам, предметам обстановки. Если отражающие поверхности находятся достаточно далеко от места выстрела и микрофона, то короткое время – единицы миллисекунд – микрофон ничего, кроме обычного шума помещения не уловит.
3. К микрофону придут редкие и тихие единичные ранние отражения – по несколько штук от пола, потолка, стен. Ранние отражения распределятся по помещению равномерно. 
4. Возникнут взаимные переотражения, которые получили название поздних отражений. Они станут все чаще и сильнее, но не перестанут быть дискретными (раздельными). Средняя энергия звука (отзвука) в помещении продолжит увеличиваться и через 90..110 миллисекунд она достигнет максимума. По уровню этот максимум будет почти такой же, как и уровень прямого сигнала.
5. После прохождения пика энергия начнет спадать, отражения будут становиться все более частыми, и через 150.. .300 миллисекунд они перестанут быть дискретными и станут диффузными, то есть взаимно переотраженными и перемешанными. При этом их уровень будет продолжать уменьшаться. 
Скорость уменьшения уровня диффузных отражений зависит от параметров помещения и определяет время реверберации – это время, за которое уровень реверберирующего сигнала уменьшается на 60 дБ.
Чем время реверберации меньше, тем выше разборчивость речи, лучше прозрачность музыки. Увеличение времени реверберации обогащает звучание, придает ему признаки объема и ощущения гулкости.

На следующем рисунке – рефлектограмме идеального помещения – представлены:
кривая средней энергии сигнала; 
полоса, отображающая плотность отражений; 
варианты возможных отклонений параметров.
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Существуют помещения с мягким и жестким установлением звука. Если звук нарастает резко и через 90 миллисекунд достигает максимума акустика будет «жесткой». Если звук нарастает плавно и достигает максимума через 110 миллисекунд – помещение будет «мягким». 
Жесткое установление звука характеризуется большим уровнем прямого звука (как в передних рядах концертного зала) и сильными ранними отражениями. Такая акустика отличается высокой прозрачностью, четкостью, выразительностью, читаемостью отдельных нот и нюансов, но более заметны стилистические и интонационные погрешности исполнения.
Мягкое установление характеризуется большей мощностью диффузного звука. При этом сглаживаются упомянутые шероховатости, увеличивается пространственное впечатление и ощущение параметров помещения.
Достаточно большое значение имеют координаты точки начала диффузных отражений: в малых помещениях они начинаются спустя 130 мс с момента тестового импульса, в больших – через 150 мс. Смещение этих значений в процессе создания модели искусственной реверберации может привести к появлению ощущения неестественности акустического отклика. 
Искажения позиционирования других точек, обозначенных на рефлектограмме (начало единичных отражений, появление ранних, средних и начальных диффузных отражений), не имеет решающего влияния на естественность акустической картины.
8.2.2. Эффекты реверберации в Adobe Audition
В Adobe Audition реализованы следуюие эффекты реверберации:
Convolution Reverb – позволяет создавать эффект реверберации на основе моделирования помещения с заданными характеристиками.
Full Reverb – эффект для моделирования реверберации с учетом размеров помещения, изменения спектра отраженного сигнала и т.д.
Reverb – позволяет моделировать реверберацию, но с меньшим количестом настроек, чем Full Reverb.
Studio Reverb – эффект для создания реверберации без моделирования помещения, за счет чего эффект получается менее требовательным к ресурсам процессора.
Surround Reverb – эффект для создания реверберации для звука в формате стерео 5.1.
Универсальная реверберация Full Reverb используется в Adobe Audition для того, чтобы в деталях моделировать акустическое пространство. Эффект обладает некоторыми уникальными возможностями:
реалистичное моделирование сигналов ранних отражений;
изменение размеров и акустических свойств имитируемого помещения;
моделирование любого материала отражающей поверхности;
изменение поглощающих свойств пространства внутри помещения;
коррекция частотного спектра сигнала реверберации с использованием трехполосного параметрического эквалайзера.
Эффект открывается командой Effects > Reverb > Full Reverb, диалоговое окно содержит две вкладки: Reverb Settings и Coloration.
В группе Reverberation имеются элементы регулировки общих параметров реверберации:
Decay Time – общее время реверберации;
Pre-Delay Time – время достижения максимального уровня эффекта;
Diffusion – поглощающие свойства среды распространения звука;
Perception – характер восприятия реверберации: от размытого звука, характерного для его отражения от большого числа близкорасположенных препятствий, до ясно различимого многократного эха;
Параметры, устанавливаемые в группе Early Reflections:
Room Size – объем помещения в кубических метрах;
Dimension – отношение ширины помещения к длине;
[image: ]Left/Right Location – точка локализации источника звука на стереопанораме;
High Pass Cutoff – частота среза фильтра высоких частот.
Set Reverb based on Room Size – автоматическое согласование общих параметров реверберации с параметрами ранних отражений, помещения и среды распространения.
В группе Output Level имеются следующие элементы управления, которые регулируют:
Dry – уровень необработанного сигнала;
Wet (Reverb) – уровень сигнала, обработанного эффектом.
Wet (Early Reflections) – уровень ранних отражений.
График на вкладке Coloration – это амплитудно-частотная характеристика трехполосного параметрического эквалайзера, через который пропускается сигнал реверберации. 
8.3. Изменение длительности и тона
Инструмент Time And Pitch > Stretch and Pitch позволяет изменять высоту звука, длительность или оба данных параметров одновременно. Данный эффект можно использовать для транспонирования песни (не изменяя темп композиции), или для изменения скорости без изменения высоты тона.
[image: ]Параметр New Duration позволяет задать длительность звука после обработки.
В группе параметров Stretch and Pitch задаются параметры:
Stretch – величина сжатия/растяжения звука (меньше 100% -сжатие, больше 100% - растяжение);
Pitch – на сколько (в полутонах) изменится тон звука (в одной октаве 12 полутонов).
Параметр Solo Instrument Or Voice задает более точную обработку для звука с единственным инструментом или голосом. Параметр Formant Shift определяет, на сколько полутонов будут смещены форманты гласных звуков.
Контрольные вопросы
1. Эффект дилей, эхо.
2. Эффекты модуляции: хор, фленджер, фэйзер.
3. Распространение звука в замкнутом пространстве.
Задание
Исходя из поставленной задачи применить необходимые эффекты. Внести в отчет описание и результаты работы по каждому при-меняемому инструменту.
Предоставить фонограмму до и после процесса обработки.
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